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Introduction To This Guide

About This Guide

This guide outlines the preparation, system requirements, processes and procedures for 
migrating existing Microsoft Exchange, POP or IMAP users onto the Scalix mail system. It cov-
ers only the migration process. For installation or use of the system, see the other, related 
product manuals.

Contents of this Guide

Included in this guide are the following topics:

• “Introduction To Scalix” on page 12

• “System Requirements” on page 17

• “Planning Your Migration” on page 19

• “Case Studies in Mail System Migration” on page 31

• “How Coexistence Works in a Phased Migration” on page 36

• “Task 1: Fine-tuning LDAP on the Scalix Server” on page 50

• “Task 2: Creating the Synchronization Agreement” on page 52

• “Task 3: Completing the Initial Directory Synchronization” on page 59

• “Task 4: Migrating Public Folder Data to Scalix Server” on page 64

• “Task 5: Loading Scalix Server Mailboxes” on page 69

• “Task 6: Reconfiguring Auto-Forward for the New Scalix Mailboxes” on page 71

• “Task 7: Configuring Message Forwarding from Exchange to Scalix” on page 73

• “Task 8: Migrating Mailbox Data with SMT” on page 78

• “Task 9: Decommissioning the Exchange Mailboxes” on page 88

• “Task 10: Post-Migration and Coexistence Closure Tasks” on page 91

• “Task 1: Activating Auto-Forwarding on Microsoft Exchange” on page 104

• “Task 2: Preparing the Exchange Users Distribution List” on page 109

• “Task 3: Configuring a TNEF route for Exchange Users” on page 111
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• “Task 4: Fine-tuning LDAP on the Scalix Server” on page 114 Phased

• “Task 5: Creating the Synchronization Agreement” on page 116 Phased

• “Task 6: Completing the Initial Directory Synchronization” on page 123 Phased

• “Task 7: Updating Exchange and Scalix Directories” on page 127

• “Task 8: Updating the Client Directory Access” on page 128

• “Task 9: Hiding Directory Entries in Scalix Server” on page 130

• “Task 10: Preparing for Public Folder Migration” on page 132

• “Task 11: Migrating Public Folder Data to Scalix Server” on page 136

• “Task 12: Enabling Public Folder Forwarding on Scalix Server” on page 141

• “Task 13: Enabling Public Folder Forwarding Capabilities on Exchange” on page 144

• “Task 14: Effective Distribution List Coexistence” on page 148

• “Task 15: Planning the Exchange to Scalix Migration” on page 151

• “Task 16: Provisioning Scalix Server Mailboxes” on page 153

• “Task 17: Bulk Mailbox Provisioning and Configuration” on page 155

• “Task 18: Reconfiguring Auto-Forwarding for the New Scalix Mailboxes” on page 159

• “Task 19: Configuring Message Forwarding from Exchange to Scalix” on page 160

• “Task 20: Decommissioning the Exchange Mailboxes” on page 165

• “Task 21: Post-Migration and Coexistence Closure Tasks” on page 168

• “Completing an IMAP–IMAP Mail System Migration” on page 181

• “Guide to Synchronization Commands” on page 189

How to Use This Guide

This guide uses the following typographical conventions:

Table 1: Typographical Conventions and their Explanations

Typographical 
Convention

Explanation

<Angle Brackets> Values that you need to supply on your own are shown within angle brackets.

Numbered and alphabetized 
lists versus bullets

Numbered and alphabetized lists denote steps to be followed while bullets provide infor-
mation.

Buttons
The larger boldface Verdana font indicates a button, a link, a field or any other UI element 
to click or press as well as a keyboard stroke. For example: Click Finish. Or In the 
Username field.

Code This smaller Lucida font indicates a piece of code to write or run. For example: 
Launch scalix-installer.sh
10
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Using the CLI

As with any procedure done on the command line, there may be more than one way to 
accomplish many of the tasks outlined in this manual. In many cases, these procedures are 
intended only as examples of how to complete a setup or configuration. If another method is 
more comfortable or more in keeping with your unique setup, it may be the best approach.

In addition, Scalix offers complete man pages for all commands. Please consult them when-
ever needed.

Identifying the Instance Home Directory

Throughout the various migration procedures, there are repeated references to the 
instance’s home directory, known as “~”. The location of this directory varies depending on 
how you ran your initial setup. For example, if you named the instance when you created it, 
the home directory becomes /var/opt/scalix/<instance>/s, where <instance> is a two-letter 
code created from the first and last letter of the instance name. If the instance is unnamed, 
the home directory becomes /var/opt/scalix/<nn>/s where <nn> is the first and last letter 
of the host name for that instance.

To determine the home directory for a particular instance, look in /etc/opt/scalix/
instance.cfg for the appropriate value of OMDATADIR.

Related Documentation

Other Scalix product manuals include:

• Scalix Installation Guide

• Scalix Server Setup Guide

• Scalix Administration Guide

• Scalix Client Deployment Guide

• Scalix Evaluation Guide

In addition, there are online help systems in:

• Scalix Management Console

• Scalix Web Access

• Outlook (if enabled for the Scalix connector)

Document Names References to other documents appear in italic font.

Italics Indicates a directory path, a file or the name of a window or dialog box. For example: Go 
to /var/opt/scalix. Or: You see the Reply screen.

Table 1: Typographical Conventions and their Explanations

Typographical 
Convention

Explanation
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Introduction To Scalix

This chapter introduces the Scalix system: Its different editions, access levels and licensing 
system.

Contents
This chapter includes the following information:

• “About the Scalix System” on page 12

• “About Scalix Product Editions” on page 13

• “About Scalix User Types” on page 15

• “Required Licenses” on page 15

About the Scalix System

Capitalizing on a proven technology foundation and the openness of Linux, Scalix gives 
enterprise customers a simple to manage, highly reliable, and feature-rich Linux email and 
calendaring platform.This offers superior price and performance advantages with greater 
security, reliability, performance, openness and flexibility, when compared to other operat-
ing and messaging systems.

Based on open standards and a proven email server technology foundation, Scalix enables 
customers to create a robust and scalable environment that is flexible enough to adapt to 
their changing needs over time. The Scalix platform scales up to support organizations with 
hundreds of thousands of users and scales down for offices with fewer than one hundred 
users, making it a viable alternative for a broad range of organizations.

The Scalix architecture supports virtually any email client and device, without loss of func-
tionality or data integrity. This means full-function support for popular clients like Microsoft 
Outlook and Novell Evolution, as well as the broad range of POP or IMAP clients available. 
Users can count on advanced features like enterprise calendaring and scheduling with real-
time free/busy lookup, contact and task management, public folders, rich text formatting, 
offline folder synchronization, secure delegate access to calendar and email, email rules 
and more. 
12
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About Scalix Product Editions

Scalix offers three editions of its powerful email and calendaring platform based on Linux 
and open systems: Scalix Enterprise Edition, Small Business Edition and Scalix Community 
Edition.

Scalix Enterprise Edition is the company’s flagship product and is ideal for organizations 
that demand the full range of functionality in a commercial email and calendaring system. It 
includes multi-server support, unlimited number of Standard users, any number of Premium 
users, the full complement of Scalix advanced capabilities, and a wide variety of technical 
support options.

Scalix Small Business Edition targets organizations getting started with a commercial ver-
sion of Scalix that do not have the higher end requirements of Enterprise Edition. It is func-
tionally equivalent to Enterprise Edition except that it allows only single-server installations 
instead of multi-server, and does not include the capabilities for high availability and multi-
instance support.

Scalix Community Edition is the free, single-server, unlimited-use version of the Scalix 
product and is great for cost-conscious organizations that desire a modern email and calen-
daring system but do not require advanced groupware and collaboration functionality for 
their entire user population. It includes unlimited Standard users, twenty-five free Premium 
users, a subset of Scalix functionality, and fee-based, incident-based technical support. 

The following table compares the Scalix product editions in greater detail:

Table 1: Product Editions and their Features

Product Feature Community 
Edition

Small Business 
Edition

Enterprise 
Edition

User Types

Standard Users Free, unlimited Free, unlimited Free, unlimited

Premium Users Included: 25
Max: 25

Included: 50
Max: Unlimited

Min Purchase: 25
Max: Unlimited

Core Functionality

Email & calendaring Server Single-server Single-server Multi-server

Internal user directory [X] [X] [X]

Choice of GUI-based or command 
line installation and administration [X] [X] [X]

Unlimited POP/IMAP email client 
access [X] [X] [X]

Native MS Outlook support (via 
MAPI)

Premium users only (max 
25) Premium users only Premium users only

Fully functional AJAX web client 
(Scalix Web Access)

[X]
(group scheduling in calen-
dar for 25 premium users 
only)

[X]
(group scheduling in 
calendar 
for all premium users)

[X]
(group scheduling in 
calendar 
for all premium users)
13



Scalix Migration Guide | Introduction To Scalix
Native Novell Evolution support

[X]
(group scheduling in calen-
dar for 25 premium users 
only)

[X]
(group scheduling in 
calendar 
for all premium users)

[X]
(group scheduling in 
calendar 
for all premium users)

Public folders Premium users only
(max 25) Premium users only Premium users only

High availability Not available Not available [X]

Multiple instances per server Not available Not available [X]

Migration tools Not available [X] [X]

Upgrade To Enterprise Edition Via license key.
Re-installation not required

Via license key.
Re-installation not 
required

Not applicable

Mobile Access [X] [X] [X]

Ecosystem Support

Meta-directory support via LDAP [X] [X] [X]

iCal support [X] [X] [X]

Native Exchange Interoperability 
(via TNEF) Not available [X] [X]

Active Directory integration with 
MMC plug-in Not available [X] [X]

Anti-virus Via flexible 3rd party inter-
face

Via flexible 3rd party 
interface

Via flexible 3rd party 
interface

Anti-spam Via flexible 3rd party inter-
face

Via flexible 3rd party 
interface

Via flexible 3rd party 
interface

Archiving Via flexible 3rd party inter-
face

Via flexible 3rd party 
interface

Via flexible 3rd party 
interface

Wireless email & PIM Email-only via POP/IMAP Email & PIM via Notify Email & PIM via Notify

Technical Support

Community Forum Free Free Free

Knowledgebase, Tech notes Free Free Free

Incident-based Support Fee-based Fee-based Fee-based

Software subscription Not available [X] [X]

Premium 7x24 Support Not available [X] [X]

Cost

Licensing Free, unlimited use $995 for First 50 Pre-
mium Users

Per-user License; No 
Per-server Fees

Table 1: Product Editions and their Features
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About Scalix User Types

Scalix users can be defined as Standard or Premium users, as defined in the following:

Standard Users
Standard users gain access to a subset of Scalix functionality including email, personal cal-
endar and contacts through Scalix Web Access and Novell Evolution as well as email access 
using POP/IMAP clients. The ability to deploy standard users is ideal for cost-conscious orga-
nizations with users who do not have high-end groupware and collaboration requirements. 
An unlimited number of standard users may be deployed with any Scalix edition for free. 

Premium Users
Premium users have access to the full benefits and functionality of the Scalix email and cal-
endaring system. The following Scalix product capabilities are available only to premium 
users: 

• Native MS Outlook support (via MAPI) 

• Group scheduling functionality including free/busy lookup in Outlook, Scalix Web 
Access and Evolution clients

• Access to public folders

• Wireless email and PIM

Any number of licensed premium users may be deployed with Scalix Enterprise Edition. 
Scalix Community Edition is limited to a maximum of twenty-five (25) free premium users, 
who enjoy many of the features available to Enterprise Edition premium users.

Flexible, Cost-Effective Email For Everyone
The distinction between standard and premium users provides organizations with the flexi-
bility to cost-effectively provide email for all users. For example, manufacturers and retail-
ers may desire headquarters staff to be designated as premium users as they require 
advanced groupware capabilities, while less demanding users, such as shop floor or store 
personnel, would be satisfied as standard users with only email and personal calendaring 
capabilities. Similarly, educational institutions may decide that faculty and staff are pre-
mium users that need advanced collaboration capabilities while students are standard users 
that just need email and personal calendaring. There is no cost for deploying standard users 
with either Scalix Community Edition or Scalix Enterprise Edition. 

Required Licenses

Scalix Community Edition, Small Business Edition and Enterprise Edition use the same 
installer. The main difference is that Small Business Edition and Enterprise Edition require a 
license key while Community Edition does not. Additionally, if you are a Scalix Community 
Edition customer, you can only perform the “typical” installation, in which all the Scalix 
components are stored on a single host computer.
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To activate your Scalix system as either a Small Business or Enterprise Edition system, you 
must enter a license key at a strategic point in the installation process. Please obtain your 
Scalix license key and have it ready for use before installing Scalix 10.0 or 10.0.1. 

You may proceed with the installation without a license key, however, your system is 
treated as a Community Edition system and your users as Standard users until the correct 
license key is entered by means of the Scalix Management Console. 

Additionally, you can install Scalix Enterprise Edition onto a single host, or distribute the 
primary components onto separate hosts—both of which are detailed fully in this guide.
16
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System Requirements

This chapter details the requirements for running the Scalix migration tool.

Contents
This chapter includes the following information:

• “Approved Software and Client Components” on page 17

Approved Software and Client Components

Scalix is compatible with the following versions of Windows, Outlook and Scalix. 

* Scalix 10.0.0 and its associated versions do not support internationalization, so only 
support the English and German languages.

Table 1: Approved Software and Client Components

Components Requirements

Exchange Versions
• Exchange 5.5
• Exchange 2000
• Exchange 2003

Outlook Versions • Microsoft Outlook versions XP and 2003 or later with service pack 2 
(versions 10, 11)

Windows OS versions

• Windows 2000
• Windows XP
(All earlier versions of Windows are not supported, regardless of which 
version of Outlook you have installed.)

Scalix Versions
• Scalix 10.0.0 and above *
• Scalix 11.0.0 and above

MAPI Connector • Scalix Connect for Microsoft Outlook version 10.0.0 or above
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Part 1

What are the 
Migration Options?



Planning Your Migration

This section explains the options for migration, which tools to use, and how to plan.

Contents
This chapter includes the following information:

• “What are the Options?” on page 19

• “Decision: To Migrate User Data or Not” on page 20

• “Decision: Who Does the Migration?” on page 20

• “Migration Strategies and Their Benefits” on page 21

• “Migration Strategies for Specific Formats” on page 21

• “What is Involved in Each Migration Method” on page 22

• “Which Migration Method is Best?” on page 24

• “Achieving Successful Coexistence” on page 25

• “Picking a Mailbox and Directory Provisioning Method” on page 26

• “Continuing Coexistence” on page 29

What are the Options?

You are about to move all users and possibly their message archives and other data from an 
old mail system to Scalix. What are the options?

There are two principal methods:

• A “flash” migration is best used with fewer users and smaller quantities of data. It 
transfers all users and data to Scalix in a day or two - usually a weekend. Users are 
told to stay off email for that weekend and on Monday, the new server is online, ready 
for a new work week.

• A “phased” migration is best when there are large numbers of users with large quanti-
ties of data that are best moved in smaller bunches, a few at a time. The complexity 
of data is the critical deciding factor; if you are migrating mail, notes, scheduling, and 
more, phased migration may be the better choice.
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In a phased migration, you set up a state of coexistence, in which both Scalix and leg-
acy mail servers work in tandem while small batches of users are transfered over to 
the new system at strategic intervals.

The Key Considerations
The primary concerns are the number of users and how much data each user has. 

• With a POP server, you can either migrate the basic user data (as the mail is stored on 
the user’s client) or recreate all-new records in Scalix.

• With an IMAP- or MAPI-based system, if you are either not transferring users’ data, or 
your users will copy their own data over, your migration can be a “flash” process. 

If your system is IMAP or MAPI, and you have more than 100 users, all of whom expect their 
files and data to be accessible in Scalix, your migration will most likely be “phased”.

Decision: To Migrate User Data or Not

You must decide whether any, or all of the user data needs to be migrated. Data migration 
is the most time consuming task of the overall project, whether it is executed by the admin-
istrators or the end-users.

Consider the alternative: Migrating users to “green field” (empty) mailboxes. This offers sig-
nificant benefits—

• Much less work to migrate large groups of users onto Scalix

• Eliminates the majority of time-consuming efforts by the IT staff

• Reduces overall size of Scalix message store

• Streamlines backup efforts initially

• Enables implementation of new email retention and mailbox quota policies 

Moving users to Scalix mailboxes without any of their pre-existing data doesn’t mean the 
data is lost, or will never be transferred. Most email clients have the ability to keep a locally 
stored copy of the legacy email data. 

Decision: Who Does the Migration?

Who actually completes the data migration is another important consideration. There are 
typically two options:

• The users themselves

• The Information Technology resources.

Often organizations jump to the conclusion that all data must be migrated by the IT team, 
when in fact an end-user-executed local data migration strategy might be ideal.

One approach that might work for your organization is to coordinate the data-migration 
activities of both users and IT staff. First, provide a special timeframe, plus instructions for 
all of the users to execute the migration themselves. At the same time, have emergency 
assistance for those users who need help.
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The following table presents the possibilities for user data migration:

Migration Strategies and Their Benefits 

Migration Strategies for Specific Formats

Potential Migration Strategies for POP3 Server Data
Due to the fact that all mail has been “popped” to each user’s local computer in a POP-
based system, data migration options are limited, and are best left to the client user. If the 
same email client that connected to the POP-based legacy system is used to connect to 
Scalix, then all legacy data remains fully accessible. If a new email client is used to connect 
to Scalix, then it should be determined if the old client’s data can be exported in a format 
compatible with the new email client (such as a .PST format for Outlook clients).

At a minimum, users can leave their legacy email client installed on their computers, pro-
viding access to the local POP mail archives. They can copy-and-paste the original content 
into any outgoing messages created and sent by means of their new email client. 

Potential Migration Strategies for IMAP Server Data
IMAP servers offer more migration options: Client users can copy the data to their local com-
puters, or IT staff can use a migration utility application to extract/import data from more 
than one user onto the Scalix system.

Table 1: Strategies and their Benefits

No Data 
Migration

Client-side 
Data Migration

Server-side 
Data Migration

Process

Data is left in the legacy 
message store and will 
continue to be accessible 
through the legacy mail 
client.

Data is extracted from the leg-
acy email client in a format that 
can be imported into the new 
email client. Or, the same leg-
acy email client is used to 
access the Scalix system.

Using the available migra-
tion tools, user data is 
transferred directly from 
the legacy mail store into 
the Scalix mail store.

Advantages

Dramatically streamlines 
overall project efforts
Clean start with “green 
field” (empty) Scalix mail-
boxes.

Legacy data is still accessible 
within the email client.
If legacy system was POP or 
IMAP, the user retains full reply 
capabilities.
Clean start with “green field” 
(empty) Scalix mailboxes.

All data remains accessi-
ble in the same server-
side folders.
Full reply capabilities.
No end-user involvement.

Disadvantages

Accessing legacy data is 
somewhat cumbersome.
Minimal capabilities with 
legacy mail data 
(copy and paste).

The same procedure must be 
manually executed at every cli-
ent workstation (either by end-
users or IT staff).

Requires more work 
behind the scenes by IT 
staff.
Dedicated migration work-
station required.
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Email data is stored directly on the IMAP server, but because most IMAP servers also support 
POP3 access, most email clients allow the user to download the data to a local store. This 
means at a minimum the POP-specific options explained in the previous section are applica-
ble to IMAP client users. 

The recommended migration utility, The Scalix Migration Tool (SMT), has IMAP capabilities 
and can extract user data from the legacy IMAP server in bulk (one or more users at a time). 
Next, IMAP should be used (as the target) to import the data into Scalix. This is arguably the 
best migration option from any IMAP server to Scalix and should also be considered as the 
best migration methodology for proprietary messaging servers that provide IMAP support 
(Groupwise, Exchange, Notes, etc.).

Possible Migration Strategies for Proprietary Data Formats
Messaging systems such as Groupwise, Exchange and Notes typically provide support for both 
IMAP and POP, but they also utilize RPC-based communication that enables extended capa-
bilities or properties within the message data. This means much of the data is in a propri-
etary format. Although the POP and IMAP strategies discussed in the previous sections could 
be used to extract data from these systems, some loss of message fidelity or exclusion of 
some data types might occur.

These systems usually permit a mail client user to save all server mail data in a local storage 
file (such as an Outlook .PST file). If the original email client can connect to Scalix, or a new 
email client is used that can access or import the local storage file, then all the legacy data 
becomes available. Note, however, that the message headers in the local archive may not 
contain standards-based (RFC 822/823) address definitions (being proprietary formats). As a 
result, replies to the messages may not route correctly, but forwarded copies will send cor-
rectly. 

Bulk server-to-server migration is also possible for many of these proprietary email products 
by means of the Scalix Migration Tool. Using SMT provides broader support for different mes-
sage formats and address resolution mechanisms. This assures full reply capabilities to all 
legacy messages and the ability to migrate most non-message data (calendars, tasks, notes, 
contacts, etc.) from the legacy system.

After extracting data from the legacy mail system, you import that file into Scalix using 
either MAPI or IMAP.  An IMAP extraction from the legacy environment and subsequent IMAP 
import into Scalix processes approximately 1 GB of data in 60 minutes.

What is Involved in Each Migration Method 

After considering how much user data to migrate, review the overall user/data migration 
methodologies. Transferring users (and any user data) from the legacy mail system to Scalix 
is done in one of two ways:

• Migrating your user base all at once (a “flash” transition)

• Migrating separate subgroups of your user base at different times (a “phased” transi-
tion)

Each of these is detailed in the following sections.
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Flash Transition
A flash transition simply means that the entire user base is migrated from the legacy system 
to Scalix at one time. There is no interim period where some users are on Scalix and others 
are still on the legacy system. A flash transition is an obvious choice for smaller organiza-
tions, or organizations whose user-data migration requirements are minimal.

The typical flash migration follows these steps:

1 Provision (set up) the needed Scalix mailboxes and directory entries 

2 Transfer the users and their data to Scalix

3 Change the MX record to the Scalix server

A flash migration ise significantly less complex than the phased approach for several key 
reasons:

• There is no need to configure auto-forwards on either server

• There is no need to continually synchronize directories on each server

• The overall migration project is simpler, and can be executed much more quickly

While this seems like a logical approach, due to its simplicity, it is often dismissed by orga-
nizations with a large number of users to migrate. There are drawbacks to a flash transition:

• There may be too much data to migrate in the short period of one weekend. (Flash 
migrations ideally occur over a single weekend such that when system users log in on 
Monday, all their data is present.) 

• There may be a spike in end-user requests for assistance if they are unfamiliar with 
the new system.

While these fears may in some circumstances have some validity, it is important to explore 
several options to reduce them.

• Spending a little more time in advance planning to produce tools for end users to get 
help: instructions, quick-reference guides, knowledgebase material, etc.

• Maximizing the appropriate usage of DNS. You can inform users in advance that the 
switch to the new mail system will occur at 6:00pm on a Friday night. Switching MX 
records or C-names to the new systems could occur right at 6:00pm, but all mailboxes 
are actually be provisioned in advance of this. They would have full mail capabilities 
and any new mail that arrives after 6:00pm from on the new Scalix environment. Leg-
acy mail however might not be available in the Scalix mailbox until Monday. 

• Optional: Employ an end-user-executed data migration strategy for either all or a sig-
nificant portion of the users. This minimizes the amount of server-side data to 
migrate. 

• Retain user access to the legacy data on the legacy server until the data is fully 
migrated.

Phased Transition
A phased transition, where only a partial amount of users are migrated at a time, means the 
two messaging environments must coexist until the transfer is complete. Coexistence 
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requires some careful set-up procedures, but can be utterly transparent to system users who 
have no idea their mail and data is moving from one system to another.

The typical phased migration follows these steps:

1 Set up message routing 

• Configure routing between Scalix and the legacy system

• Make necessary DNS changes (adding any needed MX records)

2 Synchronize and provision the Scalix system 

• Load all mailboxes and/or directory entries 

• Configure the forwarding mechanism on mailboxes (for coexistence)

3 Set up coexistence processes on the legacy system 

• Load custom recipient/contact entries

4 Transfer the first subgroup (users and their data)

• Migrate legacy data to the local store, then to the Scalix message store

• Activate just-migrated mailboxes on Scalix

• Configure migrated mailbox auto-forwarding on legacy system

5 Repeat step 4 at strategic intervals, until all groups of users and their data are 
transferred to Scalix.

6 Make the necessary MX record changes, redirecting inbound internet mail to Scalix. 

7 The legacy server could be left in place for a period of time, and eventually decom-
missioned for other uses.

Which Migration Method is Best?

After you take the following inventory of your system, you’ll have a good idea which 
method—flash or phased—you’ll be able to utilize.

How many mail users are to be migrated? 

A: The number is not as critical as the amount of user data (messages, contacts, notes, 
tasks, etc.) that will—or won’t—be transferred with each user.

Will user data be copied to Scalix or will other access points to their archives be pro-
vided to users? 

A: If you don’t want to transfer user’s IMAP system data to Scalix, you may want to 
convert the old system to a client-accessible archive instead. 

How much of which data types will be migrated?

A: Is it just messages, or does it include calendars, contacts, tasks, notes, folders?

Will mail users be involved in the process?

In some cases, you can employ your mail user base to copy their own messages to 
Scalix, or transfer them to their own client computer for archiving.

Is a coexistence period necessary or can all users be migrated at once?
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A: That depends on this formula: Number of users plus amount of user data. As you can 
see, the more complex the data to be transferred, the more likely you’ll start a 
phased migration and have to set up coexistence.

How will the users on the two systems communicate with each other during a coexist-
ence period?

A: They’ll communicate the same way as before the migration process and they’ll have 
no awareness of the two-system coexistence.

What migration strategies did other, similar Scalix customers use? 

A: The answer to this question can be found in “Case Studies in Mail System Migration” 
on page 31.

How do I assess the success of migration, during and after it’s done?

A: Information on testing the migration in progress or at the end is provided in this 
guide.

Achieving Successful Coexistence

If you choose to do a phased migration, a successful state of coexistence and a satisfy-
ing migration to Scalix depend on the following. 

• All inbound internet mail must continue to be routed to the legacy mail service until 
the last user is migrated to Scalix. Only then can the MX records can be changed to 
direct mail to the Scalix service.

• Once a legacy mail service user has been migrated to Scalix, both inbound Internet 
mail and mail from other users on the legacy system is still directed to the user’s leg-
acy mailbox. You must have activated a forwarding mechanism on the legacy mailbox, 
along with an alternate directory entry in the legacy mail environment to successfully 
redirect all incoming mail to the Scalix server.

• Every newly migrated Scalix user needs access to a complete address book listing all 
users, whether on Scalix or on the legacy system. When they send email to any user, it 
should be routed to the appropriate environment (wherever the destination recipient’s 
mailbox truly exists). This means you need mailbox forwarding mechanisms and/or 
directory entries within the Scalix environment as well, to make sure mail routes to 
the legacy environment.

• Each time a user (or a group of users) is migrated from the legacy environment to 
Scalix, auto-forwarding mechanisms must be active and directory entries must be 
updated.

Additional important points to consider:

• Executing a migration between two email environments typically involves the exact 
same requirements, if a phased approach to the transition is used.

• Most email environments do, in fact, provide the necessary forwarding mechanisms for 
mailboxes.
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• Scalix provides a selection of advanced tools (sxaa, omldapsync) to execute the neces-
sary mailbox forwarding process (described in later sections of this guide) that will 
provide significant time savings.

• A flash transition is much more feasible than most organizations realize and should be 
strongly considered as a way to streamline the overall migration process.

Picking a Mailbox and Directory Provisioning 
Method

Having considered the data to be migrated, and chosen a migration methodology, you can 
now decide how you will set up the needed directory entries and mailboxes on the Scalix 
server. There are two ways to set up (or, “provision”) these items, before transferring users 
and data from the legacy mail system:

• The Scalix Management Console is adequate but inefficient, as it restricts your work to 
only one directory entry/mailbox at a time. This may not be suitable for organizations 
that want to load hundreds of users in as short a time as possible.

• Several Scalix-produced command line tools can be utilized, as each offers multiple 
options that can be used to bulk-load thousands of names into a Scalix server.

In most cases you simply need to make sure the appropriate mailboxes or directory entries 
are provided, either through ready-formatted text files or through some means of accessing 
the records on the legacy mail system. 

The primary tools for mailbox and directory provisioning (omldapsync, omaddent and 
omaddu) are detailed in the following sections:

About the Synchronizationn Command omldapsync
Any legacy messaging environment that provides LDAP support can take advantage of the 
omldapsync tool provided by Scalix. This tool not only assists in provisioning Scalix mail-
boxes with auto-forwards, but it also provides the ability to load directory objects in the 
legacy environment (such as Contacts or Custom Recipients in Exchange environments). 

The step-by-step use of omldapsync is detailed at the appropriate time, later in this user 
guide.

About the Commands omaddent and ommaddu
Scalix also provides an advanced method of loading directory entries and mailboxes using 
separate utilities, omaddu and omaddent. These can be integrated into scripts and can be 
customized for bulk data loading. Additionally the ability to load mailboxes with auto-for-
wards is provided by means of the sxaa utility.

NOTE This procedure does not support cross-system Free/Busy retrieval. So if one user is still on 
Exchange and another user has been migrated to Scalix, you will see valid Free/Busy information 
for the second user once Outlook or SWA has published it. But you will not see it for the first user. 
In addition, only Outlook or SWA publishes Free/Busy information for Scalix. This must be done 
once a user has been migrated or they won't display as having any Free/Busy information.
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The step-by-step use of omaddent and omaddu in provisioning is detailed later in this user 
guide. 

How to use omaddent
In most cases, mail server directory entries (as contrasted with mailbox entries) provide an 
easy way for the users to send mail to destinations external to Scalix (Internet recipients). A 
text file of the current directory entries can be created as follows:

CN=Smith, John/OU1=Internet/IA=john.smith@company.com

CN=Jones, Fred (Pager)/OU1=Internet/IA=216.2725566@mobile.att.net

CN=Catering Orders/OU1=Internet/IA=Creighton.Catering@sbcglo-

bal.net

This can then be imported into Scalix with this command.

#omaddent -f filename.txt

The Scalix users will now be able to select (or search for) “Smith, John”, “Jones, Fred” and 
“Catering Orders” in the Scalix address books, and the message will route to the destination 
Internet address as specified in the input file (filename.txt).

How to use omaddu
In preparation for migrating user data, you must create mailboxes on your Scalix system 
with the same parameters as those on the legacy system. New mailboxes on Scalix can be 
efficiently provisioned by means of omaddu, utilizing the bulk parameter: Enter the name of 
an input file that contains most if not all of the necessary information for a user. 

A simple way to do this is to take advantage of the automatic generators for the display 
name, internet addresses, and authentication ID, thus simplifying the contents of the input 
file to be passed to omaddu.

To prepare your Scalix system for bulk mailbox provisioning with omaddu with the 
Scalix Management Console:

1 Log in to your Scalix server (as a root user). 

2 Start your browser and connect to the Scalix server.

3 When the Scalix Management Console appears, choose Settings.

4 Set the appropriate mail address settings for generating the following:

• The Internet Address

• The Display Name Rule (which determines how the users will be displayed in the 
System Address book)

• The Authentication ID Rule

5 Note the Default Domain is appended to the Authentication ID Rule to form the 
entire Authentication ID for each Scalix account.

Once this has been established, test the provisioning process by creating a single mailbox on 
Scalix through omaddu. Following this, use omshowu to verify all values were correctly 
transferred to Scalix.

#omaddu -n "Test User/mailnode" -p pass 

Verify that the internet address and authentication ID are created correctly and the com-
mon name (cn=) value is what is desired for the System Address book. 
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To load all users, create a simple text file with their names. The format of the text file 
should look like: 

@ Firstname Lastname 

@ Firstname Lastname 

@ Firstname M. Lastname 

@ Firstname Lastname Jr. 

To verify the transfer of values:

1 Run this command:

#omshowu -n "Test User/mailnode" 

To format the text file:

1 Enter a last name (family name), up to 40 characters. This is called Surname (or 
“S”) in the X.400 syntax. 

2 Enter an optional first name (given name, i.e. “G”), up to 16 characters. 

3 Add any optional initials (for example ?K?), up to five. Each initial must be followed 
by a period (.) when you define or use the name. They are automatically capital-
ized. 

4 Enter an optional suffix (generation qualifier, ?Q?), up to 3 characters 

5 Next, the file (named "dirload.txt" in the example below) can be used to bulk load 
all users with the following command. 

# omaddu -bulk -p pass mailnode dirload.txt 

Note the -e switch can also be passed in the same omaddu command line (shown above) 
which will set each mailbox to the "pre-expired" state and force users to replace the existing 
password with a new password when they first log in to the Scalix server.

If you want deeper control you can simply specify exactly what you want for each 
user in the input file and it will override the settings in the Scalix Management Con-
sole. For example, in the input file below, for the first three users the authentica-
tion ID is specified, followed by the user’s name, then the display name, then 
primary internet address (with friendly name) and in the case of  ?Ed Ott? even a 
second Internet address. Notice however the mailbox ?Room 22? will have every-
thing but the user name automatically generated.

jdoe@SRV.LOCAL Joe Doe/CN=Doe, Joe/IA="Joe Doe" <joe.doe@corp.com>

eott@SRV.LOCAL Ed Ott/CN=Ott, Ed/IA="Ott, Ed" 

ed.ott@corp.com=eott@corp.com

tfjones@SRV.LOCAL Ty F. Jones/CN=Jones, Ty F/IA="Jones, Ty F" 

<ty.f.jones@corp.com>

@ Room 22
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Continuing Coexistence

If you are planning to operate both Exchange and Scalix servers after the initial migration, 
you will be running omldapsync on a regular basis to synchronize directories. This is entirely 
feasible, but you should remember the following, as you perform regular updates of both 
server directories:

Do not change or delete user records on the Scalix server. Always edit the 
records on the originating Exchange/IMAP server.
Then, start a new omldapsync operation to update the Scalix server.

If you synchronize directories on Scalix and Exchange, the operation involves two sequential 
unidirectional synchronizations—that are entirely independent of each other:

• Scalix users become “foreign address” entries in the Exchange GAL

• Exchange users become “Internet” users in Scalix

There is no duplication of directory entries; during omldapsync, each set of users is treated 
differently on the target server. Scalix users are kept in a separate Exchange recipients con-
tainer, and Exchange users are never given Standard or Premium user status in Scalix.

As a result, problems may arise from mistaken assumptions about “synchronization”. 

Consider this example: You synchronize a “Jane Smith” user record from Exchange to Scalix. 
Later, you either edit the Scalix “Jane Smith” record on Scalix, or delete that record from 
Scalix. (If a record originates in Exchange, resist the impulse to edit or delete it in Scalix!)

It later becomes apparent that the “Jane Smith” record should not have been changed or 
deleted. You assume that the record will be replaced in the next omldapsync operation, but 
you discover nothing has changed afterwards.

The explanation is simple, and the solution is also simple:

• omldapsync does not compare each directory (Scalix and Exchange) for changes or 
deletions in shared records, so it will not detect the missing “Jane Smith” record on 
Scalix and replace it.

• You must manually edit the files used by omldapsync (as detailed following), specifi-
cally the “Jane Smith” record”, to force omldapsync to reload that “Jane Smith” 
record from Exchange to Scalix.

How omldapsync Works
omldapsync, when run, takes a snapshot of the entire Scalix directory—including Scalix users 
and “internet” users. omldapsync also polls the Exchange directory for both kinds of users 
and notes them in the same snapshot. It then compares the aggregate snapshot file with the 
previously-saved snapshot file. Any additions or changes are then recorded in a [name] file, 
that is exported to Exchange and to Scalix.

Again, there is no direct comparison of the two server’s user directories. An intermediary 
process is used. 

Editing the omldapsync [name] File
If you accidentally delete a record on Scalix or Exchange that originated from the other 
server, you can force omldapsync to reload the original record on the destination server.
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1 Log into Scalix as root.

2 Use a text editor to open the snapshot file that contains the original "Jane Smith" 
record.

~/ldapsync/[name_of_sync_agreement]/search.last

3 Find and delete the “Jane Smith” record—and the following carriage return.

4 Save the change to the snapshot file.

5 Restart omldapsync.

After comparing the latest collection of user records with the previous snapshot, it 
will create a [name] file that will replace the missing “Jane Smith” record in the 
destination server.
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Case Studies in Mail System Migration

This chapter offers three case studies to help you understand how different migration sce-
narios can work.

Contents
This chapter includes the following information:

• “Overview” on page 31

• “Company A” on page 31

• “Company B” on page 32

• “Company C” on page 34

Overview

To help you determine which migration method to use, we offer the following case studies 
to illustrate basic strategies for mail migration used by actual Scalix customers. 

Company A

Pre-Migration Environment: 1000 users on Exchange 5.5, all using Outlook (MAPI)

Post-Migration Environment: 1000 users on Scalix 9.2, all using Outlook (MAPI)

High-Level Decisions Benefits and Implications

Architecture Single Server (dual P4, 4GB RAM, SCSI, 
RAID 5, 400GB, SCSI)

Provided approximately 300+ MB of stor-
age per mailbox, plus room for LVM 
snapshots, suitable CPU, disk and mem-
ory for  Outlook (MAPI) or SWA with 
excellent performance.
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Notes
• The installation of Scalix Connect and subsequent generation of Scalix profiles was 

executed by end users on Monday morning as a first step, followed by the entry of 
their username and password. This took about two minutes per user, with a few taking 
up to five minutes. Once the users successfully logged in to their Scalix mailboxes, all 
mail data was available.

• Instructions for using Scalix Web Access were provided for users who were not able to 
access Outlook through Scalix Connect. The IT team later helped each of these users 
attain the files to install Scalix Connect and generate the Scalix profile.

• By the close of business on Monday, approximately 90 help-desk queries were logged. 
Of these, approximately 65 were resolved in 5 minutes or less. 40 queries were attrib-
uted to users not reading the provided instructions for installing Scalix Connect. 
Another 25 queries were from the users entering invalid username or password. There 
were 12 pre-scheduled incidents for remote users who required extra assistance, and 
the remaining queries were miscellaneous issues (not understanding how to link .PST 
files, enabling off-line synchronization). On Tuesday there were only 16 help-desk que-
ries relating to email.

Company B

Pre-Migration Environment: 1800 users on IMAP server with various IMAP clients

Transition Strategy

Flash transition - no coexistence 
required. An initial load of a few mail-
boxes and testing occured, then all mail-
boxes were loaded into Scalix. MX 
records were then redirected to Scalix 
server.

Flash transition dramatically shortened 
the overall project. Post migration results 
included an initial spike in help desk 
requests due to minor end-user issues, 
mostly educational in nature. No directory 
synchronization was required.

Data Migration Strat-
egy

Deployed four migration workstations to 
accomplish full transfer over one week-
end. Pace: 125 mailboxes per day, per 
workstation in a 12 hour period.

All users accessed legacy data (mail, 
contacts, calendar, etc.) from within their 
Scalix mailbox on Monday and had full 
reply capability. Required an intensive 
weekend for the IT staff.

Provisioning Method

Used omaddu with the bulk option, and 
preset automatic generators in the Scalix 
Management Console for display name 
and Internet addresses.

Extremely fast way to create all mail-
boxes on Scalix, and automatically have 
standards for the display name and Inter-
net addresses. Required a simple flat file 
created in advance based on Exchange 
users.

High-Level Decisions Benefits and Implications
32



Scalix Migration Guide | Case Studies in Mail System Migration
Post-Migration Environment: 1600 on SWA only, 200 on Outlook (MAPI) 

Notes
• This organization declared an email outage from 9:00pm Friday evening until 6:00am 

Monday morning, and let all mail queue on the perimeter mail relay during that time. 
This provided an effective back out strategy. If the migration process had issues during 
the weekend, they could simply let the mail route to the legacy server and try again 
another weekend and users would not lose any mail. If all was successful then the 
queued mail would be routed to the new Scalix server on Sunday night. 

• No client software deployment was necessary for 1600 of the 1800 users who used 
Scalix Web Access; the other 200 on Outlook (MAPI) were provided the instructions for 
installing Scalix Connect, creating the profile and accessing their mailbox.

• All Scalix users authenticated against a corporate LDAP server through Scalix Web 
Access and Outlook. Authentication IDs were pre-loaded on all mailboxes through bulk 
load process and PAM-based authentication configuration completed with the help of 
Scalix-ready documentation.

High-Level Decisions Benefits and Implications

Architecture Single Server (dual P4, 6GB RAM, SCSI, 
RAID 1+0, 250 GB, SCSI)

Provided approximately 50+ MB of stor-
age per mailbox for SWA users (mailbox 
limits enforced), 500+MB for  Outlook 
users, and room for LVM snapshots, suit-
able CPU, disk and memory for SWA with 
snappy performance. Peak SWA logins 
were less than 300 in a 30 minute time 
period.

Transition Strategy

No coexistence required. All mailboxes 
were loaded into Scalix; inbound MX 
records were then modified at 9:00 pm on 
Friday evening.

Lack of coexistence dramatically short-
ened the overall project. IT staffers saw 
an initial spike in help desk requests due 
to minor end-user issues, mostly educa-
tional in nature.

Data Migration Strat-
egy

Used four migration workstations to 
migrate approximately 250 mailboxes per 
day, per workstation in a 12-hour period. 
Completed the entire migration over the 
weekend.

All users accessed their legacy data 
(mail, contacts) from within their new 
Scalix mailboxes on Monday with full 
reply capability. Required an intensive 
weekend for the IT staff.

Provisioning Method

Used omaddu with the bulk option, but 
because no standard Internet address 
were used, specified all values in the bulk 
input file.

Extremely fast way to create all mail-
boxes on Scalix while accounting for lack 
of standard Internet addresses, but apply 
standards to display names.
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Company C

Pre-Migration Environment:3000 users on a POP server with various POP and IMAP-support-
ing clients

Post-Migration Environment: 2800 users on Scalix Web Access only, 200 on Outlook (MAPI) 

Notes
• Outbound SMTP server setting in each legacy POP client pointed to a C-Name DNS 

entry that was then redirected to the Scalix server. This provided the users an option 
of accessing their legacy mail by means of their old POP client and simply replying.

• Many of executive-level team required their legacy mail data migrated to their Scalix 
mailbox. For these users, the Netscape client used for POP access to the legacy server 
was configured with an additional IMAP service that connected to the Scalix server. 
Once connected, this data was simply dragged and dropped into the server-side Scalix 
folders.

• The /etc/opt/scalix/webmail/partner.xml file was configured to provide LDAP 
searches against the legacy POP server in addition to Scalix system address book and 
each user’s local contacts. Since addressing in Scalix Web Access is primarily per-

High-Level Decisions Benefits and Implications

Architecture Dual Server (dual P4, 6GB RAM, SCSI, 
RAID 5, 1 TB)

Provided approximately 250+ MB of stor-
age per mailbox for all users and room for 
LVM snapshots, suitable CPU, disk and 
memory for SWA with snappy perfor-
mance. Peak SWA logins were less than 
300 in a 30 minute time period.

Transition Strategy

Transitioned in three phases. Loaded 200 
mailboxes on the first Scalix server in 
phase 1), then 1300 three weeks later. 
Loaded the final 1500 on the second 
Scalix server four weeks later.

Enabled large groups of users to be tran-
sitioned, but not too many that it over-
whelmed the support group. Did have to 
script the loading of forwards for the first 
1500 mailboxes during coexistence 
(Phase 1 and 2).

Data Migration Strat-
egy

Legacy data was left locally in the legacy 
POP store for most users; some data 
was migrated using a client-to-server 
method. 

End-users did not have legacy mail data 
inside the Scalix mailbox, but had access 
through the legacy client. Administrators  
benefited from s fresh start with empty 
mailboxes.

Provisioning Method

Used omaddu with the bulk option and 
the preset automatic generators in the 
Scalix Management Console for display 
name and Internet addresses. Also used 
the Scalix Management Console to man-
ually add extra Internet addresses for 
some users.

Extremely fast way to create all mail-
boxes on Scalix, and automatically have 
standards for the display name and Inter-
net addresses applied, and account for 
users who had been receiving mail on 
non-standard Internet addresses.
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formed through the Search Names functionality (which then uses the LDAP settings in 
the partner.xml), this enables full address book capabilities for all Scalix Web Access 
users but with only a partial amount of the mailbox actually loaded on Scalix. Even 
though there was a coexistence period, no forwards or extra directory entries were 
required.
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How Coexistence Works in a
Phased Migration

This chapter illustrates the concepts in phased migration to explain what is done—and why. 
It starts with a sequence of pictures showing how phased migration works on a per-server 
basis.

Contents
This chapter includes the following information:

• “Overview” on page 36

• “Co-Existence Steps” on page 37

• “How to Manage Mailboxes during Coexistence” on page 44

• “Coexistence in a single picture...” on page 48

Overview

In a “phased” migration, you have a lot of users and data, so you move users (and their 
data) in smaller groups, a few at a time. The complexity of data is the critical dependency; 
if you are not migrating mail, notes, scheduling, and more, the transfer from a legacy sys-
tem to Scalix can be done with a flash migration. Otherwise, it must be done carefully, in 
small groups.

If a phased migration is required, you must set up a state of coexistence in which both Scalix 
and legacy mail servers communicate with one another while you move batches of users at 
strategic intervals.
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Important! It is absolutely imperative 
that each server not share the same 

DNS entry, but have distinct address-
ing, as shown below.   

The separate DNS records must be in 
effect all through migration, as well 
as afterwards.

Co-Existence Steps

The following series of pictures shows 
how individual mailboxes are able to 
coexist during a phased migration.

sx1.acme.netmail.acme.net



Step 1

Before migration: All corporate email 
is managed by the legacy mail system 
server.

Step 2

Before migration: The new Scalix 
server is installed and configured, 
ready for use. But all corporate email 
is still managed by the legacy server.

All that’s needed is (1) to make sure 
that Scalix and the legacy system can 
cooperate/co-exist while (2) you con-
tinue the migration of the users and 
their data.



Step 3

The contents of the legacy system’s 
directory are synchronized to Scalix.

This can be done with one of three 
CLI utilities:

• omldapsync

• omloadfile

• sxaa

Step 4

Using the new Scalix directory as the 
source, migration-ready mailboxes 
are created for all listed users and 
groups. 

(All of these mailboxes are locked.)

If you use sxaa, directory pointers are 
created for all listed users and 
groups.



Step 5

An auto-forward is applied to each 
new Scalix mailbox, to automatically 
redirect any communications sent to 
Scalix back to the still-active legacy 
server.

Remember!—The legacy server is still 
managing all email, incoming and out-
going.

Step 6

Divide your legacy-system users into 
small groups of users that can be 
migrated at one time. It may be 20, 
50, 100; time and resources are the 
guides to the exact number you 
choose.

Exchange



Step 7

Starting: The actual migration of a 
group of users (and their data) begins 
with copying the contents of the first 
group of mailboxes.

Step 8

Finished: When migration of the first 
group is complete, you can:

(1) Turn off auto-forwarding on the 
just-migrated Scalix mailboxes

(2) Activate an alternate address on 
each of the just-migrated legacy 
mailboxes

(3) Or use .forward files

The legacy system now forwards all 
incoming mail to the Scalix version of 
each mailbox.



Step 9

The mailboxes are present on both 
systems. Migration now transfers the 
data from selected legacy mailboxes 
to Scalix in an orderly manner.

What’s happening: The legacy system 
is still managing all incoming email 
and scheduling communications. But 
is now forwarding all incoming mes-
sages to the just-migrated Scalix 
users. Scalix is now managing outgo-
ing communications from all migrated 
mailboxes. The servers are now 
actively coexisting.

Step 10

Migration is complete. You can now 
stop all auto-forwarding from Scalix 
back to the legacy system. All mail 
going to the legacy system is redi-
rected to Scalix mailboxes.

Firewall

MX

Exchange

Scalix
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Step 11

Done: The MX record can now be revised so that all mail goes to the Scalix Server.

From now on, the Scalix server manages all email and scheduling, or any other services for-
merly managed by the legacy system.

The legacy server can now be decommissioned and reused for other purposes.
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How to Manage Mailboxes during Coexistence

Mailbox management tasks begin after a directory synchronization with the legacy system. 
You now complete a directory-based provisioning of new mailboxes on the Scalix server.

You now have the same users on each server, though in different states.

Next, you create auto-forwarding from the new mailboxes on Scalix that route mail to the 
legacy mail system. This is a precautionary step, as the Scalix mailboxes should not be 
receiving incoming mail.

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Public Distribution List – Sales

 sales@xyzcorp.com

Remote Recipients (3)

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Sam.Jones@hotmail.com

Public Distribution List - Sales

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Public Distribution List – Sales

 sales@xyzcorp.com
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At this point, you can add a new, correct Scalix-specific address to each Scalix mailbox, and 
then turn off the precautionary auto-forward.

Locked Mailbox – Group A

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 Auto-forward to joe.smith@xyzcorp.com

Locked Mailbox – Group B 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Auto-forward to mary.jones@xyzcorp.com

Remote Recipient - Sam Jones 

 Sam.jones@hotmail.com

Public Distribution List - Sales

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Public Distribution List – Sales

 sales@xyzcorp.com

Mailbox – Group A

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 Joe.smith@sx1.xyzcorp.com

 Auto-forward to joe.smith@xyzcorp.com

Mailbox – Group B 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Auto-forward to mary.jones@xyzcorp.com

Remote Recipient - Sam Jones 

 Sam.jones@hotmail.com

Public Distribution List - Sales

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Public Distribution List – Sales

 sales@xyzcorp.com

-NEW!-
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Now you start to create a custom recipient that matches each of the users on the legacy sys-
tem, and each recipient points to that user’s Scalix-addressed mailbox.

The next step is to add a redirection address to each legacy mailbox, pointing to the corre-
sponding custom recipient. This routes all incoming mail from the original mailbox to the 
custom mailbox (on the legacy system) then to the Scalix mailbox.

Mailbox – Group A

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 joe.smith@sx1.xyzcorp.com

Mailbox – Group B 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Auto-forward to mary.jones@xyzcorp.com

Remote Recipient - Sam Jones 

 Sam.jones@hotmail.com

Public Distribution List - Sales

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Custom Recipient – Joe Smith

 joe.smith@sx1.xyzcorp.com

Public Distribution List – Sales

 sales@xyzcorp.com

Mailbox – Group A

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 joe.smith@sx1.xyzcorp.com

Mailbox – Group B 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Auto-forward to mary.jones@xyzcorp.com

Remote Recipient - Sam Jones 

 Sam.Jones@hotmail.com

Public Distribution List

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 Redirect to joe.smith@sx1.xyzcorp.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Custom Recipient – Joe Smith

 joe.smith@sx1.xyzcorp.com

Public Distribution List – Sales

 sales@xyzcorp.com
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Once this is in effect, you can deactivate the original mailbox, as the custom recipient redi-
rection process now channels all incoming mail to that user’s Scalix mailbox.

If you repeat this process with all your legacy user mailboxes, you will migrate your system 
successfully, the two servers will coexist effectively, and your mail system users will never 
notice any effect on their service.

Mailbox – Group A

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 joe.smith@sx1.xyzcorp.com

Mailbox – Group B 

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

 Auto-forward to mary.jones@xyzcorp.com

Remote Recipient - Sam Jones 

 Sam.Jones@hotmail.com

Public Distribution List

 sales@xyzcorp.com

Mailbox User – Joe Smith

 Joe.smith@xyzcorp.com

 Joe.smith@xyz.com

 Jsmith@oldco.com

 Redirect to Joe.Smith@sx1.xyzcorp.com

Mailbox User – Mary Jones

 Mary.jones@xzycorp.com

 Mary.jones@xyz.com

 Mjones@oldco.com

Custom Recipient – Sam Jones

 Sam.jones@hotmail.com

Custom Recipient – Joe Smith

 joe.smith@sx1.xyzcorp.com

Public Distribution List – Sales

 sales@xyzcorp.com

[Deactivated mailbox
for Joe Smith]
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Coexistence in a single picture...

The effect of coexistence, as pictured above, is to make sure all incoming and outgoing mail 
goes through the legacy mail system—until all mailboxes are migrated. 

Once a matching Scalix mailbox is ready and all the auto-forwarding/custom redirection 
takes effect, the legacy server continues to manage all incoming mail for that user, but it 
ends up on the Scalix server in the migrated mailbox.

At this point, outgoing mail from that user’s mailbox goes directly to the networks from the 
Scalix server, with the user never noticing a thing. All other un-migrated mailboxes are 
served as before by the legacy mail system.
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Task 1: Fine-tuning LDAP on the
Scalix Server

The chapter covers an optional procedure for modifying one key LDAP setting on the Scalix 
server.

Contents
This chapter includes the following information:

• “Overview” on page 50

• “Procedure” on page 50

Overview

If you are migrating more than one thousand user mailboxes from the Exchange server to 
Scalix Server, you must modify a key LDAP setting on the Scalix Server to increase the 
default capacity. 

Procedure

To fine-tune LDAP on the Scalix server:

1 Log in to the Scalix server as root.

2 Use an editor to open this configuration file:

~/sys/slapd.conf

The configuration file contents appear.

3 Look for and change the size limit values, which are shown in bold text in the fol-
lowing example of an sldap.conf file. 

Increase the size limit values large enough to extract all entries in the Exchange 
directory to the Scalix Server. If the migrateable mailboxes number 1,800, replace 
“1000” with “2000” (to allow for increases during the phased migration.)

database om    

suffix "o=MyContacts"    
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flatSuffix "o=MyContacts"    

directory _MYCONTACTS_    

sizelimit 1000    

timelimit 15    

useDit false    

#    

database om    

suffix "o=Scalix"    

flatSuffix "o=Scalix"    

#directory SYSTEM    

sizelimit 1000    

timelimit 15    

useDit false    

#    

database om    

suffix ""    

flatSuffix "o=Scalix"    

#directory SYSTEM    

sizelimit 1000    

timelimit 15    

useDit false  

4 Save any changes you made to the slapd.conf file.

5 To restart the LDAP service, enter this command:

omoff -a slapd

6 Wait approximately one minute and enter:

omon -a slapd

The reconfigured LDAP service is now in effect.
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Task 2: Creating the
Synchronization Agreement

This chapter covers the synchronization agreement needed to create users on the Scalix sys-
tem, based on user records from the Exchange server.

Contents
This chapter includes the following information:

• “Requirements” on page 52

• “Completing a Synchronization Agreement” on page 54

• “Using the Synchronization Command” on page 54

• “Resolving Error Messages” on page 58

Requirements

There are two requirements before beginning this procedure:

1 Collect the required information:

• Domain name or IP address of the source Exchange server

• The password for the Exchange administrator user account

2 Pre-configure the “Service Account Admin” rights/permissions for the Administra-
tor account (in Exchange) that you want to use for coexistence with Scalix. This is 
detailed in the next section.

To Add “Service Account Admin” rights to an existing user:

1 Start Exchange Administrator. 

2 Click the relevant mail site name.

3 Choose File > Properties. 
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4 When the [Name] Properties dialog box appears, click the Permissions tab. 

5 Click Add.

The Add Users and Groups dialog box appears.

6 Open the List Names From menu and choose the relevant server name.

7 In the Name list, select the relevant administrator or admin group name.

8 Click Add. 

The selected name should appear in the Add Names field below.

9 Click OK to close the Add Users and Groups dialog box.

10 If a Permissions/Domains confirmation dialog box appears, click OK to close it.

The [name] Properties dialog box reappears.
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11 Open the Roles menu and choose Service Account Admin. 

12 Click Apply, then click OK to save this new permission state and close the [name] 
Properties dialog box.

Completing a Synchronization Agreement

Before starting the agreement, you must obtain the Exchange values for the synchronization 
command (omldapsync) “a” attribute from the Exchange server. 

To find and note down these values from the Exchange server:

1 Open the Microsoft Exchange Administrator application. 

2 Select the site container that you are synchronizing. 

3 Double-click any of the current user accounts.

4 When the [User Name] Properties dialog box appears, click the E-mail 
Addresses tab.

5 Note the following X.400 values as shown here:

C= country

P= organization

O= your_site

6 Write down this information and have it ready for use in the following procedure.

Using the Synchronization Command

To configure a synchronization agreement for the Exchange-to-Scalix migration:

1 Log in to Scalix Server as root.

2 To execute omldapsync in “interactive” mode, enter this command: 

omldapsync -i syncid

• Replace syncid with a name for your Exchange-Scalix migration synchroniza-
tion agreement. The name should be no more than six alphanumeric characters 
in length. For example, Ex2Sx.

3 When the omldapsync menu appears, enter the number 1 at the prompt.

The omldapsync command determines that this is the initial directory synchroniza-
tion and creates the subdirectory for the synchronization agreement along with the 
sync.cfg file. 
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4 When omldapsync displays this prompt:

INPUT: Select sync agreement type to create (00):

5 Enter 00 (two zero’s) to specify that you are synchronizing with an Exchange 5.5 
server. 

6 When omldapsync displays this prompt:

Edit config file now y/n (n)

Enter y.

7 When omldapsync displays this prompt: 

Use vi to edit y/n (n) 

Enter n.

8 When omldapsync displays the following information:

# PART 1 General Configuration

##################################################################

. . .

EX_HOST[]:

Enter the fully qualified domain name or IP address of the Exchange server at the 
EX_HOST prompt. Use this format for the entry:

server.domain.ext

• The EX_ variable indicates an export from the Exchange server.

9 When omldapsync displays the following prompt:

EX_LOGON[Export Admin]:

Enter the Exchange Administrator account user name. 

10 When omldapsync displays the following prompt:

EX_PASS[]:

Enter the Exchange administrator password.

This password automates the entire migration process. If you do not enter the pass-
word, omldapsync prompts you for a password every time you run the command. If 
security is a question, the password is saved in the sync.cfg file and is protected by 
the security policies configured for the Linux host system on which Scalix Server 
operates. 

11 When omldapsync displays the following information:

# PART 1.2 for IMPORT/EXPORT - local host

#########################################

NOTE After you are familiar with the synchronization agreement process and the VI editor, you can 
enter y at the Use vi to edit y/n (n): prompt if future configuration changes are needed. For the ini-
tial configuration, enter n so that the omldapsync command can step you through configuration of 
the sync.cfg file. 
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. . . 

IM_LOGON[Import Admin]:

Enter the Scalix Server administrator user name. 

12 When omldapsync displays the following prompt:

IM_PASS[]:

Enter the Scalix Server administrator password.

As noted previously, entry of the password automates the entire migration process. 

13 When omldapsync displays the following information:

# PART 1.3 for IMPORT - ldap parameters

#######################################

. . .

EX_BASE1[cn=recipients,ou=your_site,o=your_org]:

Enter the Exchange Global Address List (GAL) container. The entry should be in the 
following format:

cn=container name,ou=site,o=organization

This parameter defines the Exchange GAL container, where “cn” defines the name 
on the GAL container (that you want to migrate), “ou” defines the Exchange 5.5 
site, and “o” defines the name of the organization (domain). You can specify up to 
three containers using the subsequent prompts (EX_BASE2 and EX_BASE3)—but only 
if you have more than one container. If not, EX_BASE is sufficient.

14 When omldapsync displays the following information:

IM_OMADDRESS[/remote,tnef]:

15 Enter the route you want to use throughout the duration of migration coexistence. 

16 When typing the route name, type only the name (not the “tnef” text) and be sure 
to enter a “/” preceding the name. For example:

For example:

/route_name

17 When omldapsync displays the following:

# PART 1.4 for EXPORT - ldap parameters

#######################################

IM_LOCAL_DOMAIN[@scalix_server.your_domain.com]:

Enter the domain portion for the Scalix Server SMTP address of the user. 

Your entry should be in this format:

@scalixserver.domain.com

Alert Enter just the user name, NOT the “@domain” texts.
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The parameter for this command is configured as the local mailnode domain. 
Because message routing already exists for the Exchange system, Scalix Server is 
configured to coexist alongside the Exchange mail system without having to modify 
the message routing topology. This requires that you use @scalixserver.domain.com 
format for this command. Although entries that Scalix Server imports to Exchange 
use this format, the external address of a user remains name@domain.

18 When omldapsync displays the following prompt:

EX_DN_SUFFIX[cn=ldapsync-

sync_agreement_name,ou=your_site,o=your_org]

Enter the location for the exported entries. 

• The container name (cn=) should be a name that you previously created for 
Scalix users. 

19 When omldapsync displays the following prompt:

EX_TEXT_EOA[c=US;a= ;p=your_org;o=your_site;]:

Enter the address where the entries are to be exported. 

For example:

c=country;a= ;p=yourorg;o=yoursite;

• Enter the X.400 value you previously noted down from Exchange (as detailed 
earlier in this chapter) for the a= attribute.

20 When omldapsync displays the following information:

# PART 2 Mapping Configuration

#################################################################

. . .

# END

#################################################################

Result=0

INPUT: Compare old config with new y/n (n): 

Enter y at the prompt.

21 When omldapsync displays the following prompt:

INPUT: Replace old config with new y/n (?): 

Enter y at the prompt.

22 When omldapsync displays the following information:

INPUT: Attempt to test data extraction now y/n (n):

Enter y at the prompt.

Output similar to the following (for an example agreement named “sa1”) should 
appear on-screen: 

INFO: test searching from bamex55.bamail.net ... 

INFO: search base is cn=Recipients,ou=BAMUS,o=bamail
57



Scalix Migration Guide | Task 2: Creating the Synchronization Agreement
INFO: ... test searched OK. 

INFO: test searching from localhost ... 

INFO: search base is o=Scalix 

INFO: ... test searched OK. 

STATUS: Configuration of sa1 completed ########

This completes the agreement setup process.

Resolving Error Messages

If any WARNING or ERROR messages appear during this procedure, verify the synchronization 
agreement.

To verify the agreement:

1 While logged in to Scalix, enter this command:

omldapsync -i syncid 

Replace syncid with the name of the Exchange-Scalix migration syn-
chronization agreement. 

2 When the omldapsync menu appears, enter 1 and press Enter.

The synchronization agreement is now complete and ready for use.
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Task 3: Completing the Initial
Directory Synchronization

This chapter covers how to run the initial directory synchronization

Contents
• “Overview” on page 59

• “Synchronizing the Directories” on page 59

• “Managing Errors” on page 60

Overview

After you complete the synchronization agreement, you can now synchronize the directories 
on the Exchange and Scalix servers. As with the agreement procedure, you will execute the 
omldapsync command in interactive mode and enter the Exchange-Scalix synchronization ID 
you previously configured.

The initial directory synchronization process does the following:

• Exports all entries in the Exchange LDAP container specified in the synchronization ID 
file

• Adds all entries to the Scalix Server directory

• Converts Distribution Lists into Public Distribution Lists in Scalix Server

• Imports all entries from Scalix Server 

• Adds all entries to the specified Exchange container

Synchronizing the Directories

To synchronize the directories for the first time:

1 Log into Scalix Server.

2 To execute omldapsync in “interactive” mode, enter this command: 

omldapsync -i syncid
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• Replace syncid with the name of your Exchange-Scalix migration synchroniza-
tion agreement. 

3 When the omldapsync menu appears, enter the number 2.

This prompts omldapsync to synchronize the directory for the first time. 

When you see the “export sa1 completed” confirmation message, the synchroniza-
tion is complete, and was successful.

• If any error messages appear, follow the procedure in the next section to 
resolve the situation.

Managing Errors

It is not uncommon to encounter minor errors during the directory synchronization process. 
The omldapsync command notifies you of errors that occur during the synchronization of 
directories and provides an option to manage errors so that synchronization continues unin-
terrupted.

The following procedure describes a scenario in which the Exchange Distribution List repre-
senting the Scalix Server users was added and an error occurs when Scalix Server attempts 
to export the Distribution List.

1 Execute omldapsync in “interactive” mode by entering the following command: 

omldapsync -i syncid

2 When the omldapsycn menu appears, enter 3.

The following information displays:

STATUS: LDAP dir sync import sync01 started ###############

...

INFO: ... 0 entries to delete

INFO: ... 2 entries to add

INFO: ... 1 entries to modify

STATUS: delete old entries from flipper.bamail.net ...

INFO: ... 0 entries deleted

STATUS: add new entries to doclab.bamail.net ...

adding new entry cn=Scalix UsersDL,o=Scalix

ldap_add: Already exists

adding new entry cn=sName,o=Scalix

The ldap_add process notifies you that an entry already exists (this is where the 
Distribution List originated). 

3 If you intentionally added the Exchange Distribution List knowing that omldapsync 
generates errors in this situation, you can “accept” the error by entering the fol-
lowing at the omldapsync prompt:

omldapsync -i syncid
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4 When the omldapsync menu appears, enter 4 to accept the error and update the 
directory. 

The directory synchronization should  now be complete.
61



Scalix Migration Guide | Task 3: Completing the Initial Directory Synchronization
Resetting After a Failed Synchronization

There are multiple scenarios in which you would want to reset the Scalix after an initial 
omldapsync from Exchange is completed. 

1 Create a file with the name of all of the mailboxes that were to have been synchro-
nized in the first attempt. To do so, run this command:

omshowu –m all > allmailboxes.out

2 Use your preferred editor and open the file allmailboxes.out.

3 Delete the lines that contain the two system accounts: sxadmin and sxqueryadmin. 
These mailboxes should not be deleted along with the others.

4 Purge the other mailboxes by running this command:

omdelu –f allmailboxes.out

5 To create a new list of directory entries that you want to migrate to mailboxes, run 
this command:

omsearch –e “cn=*” –m cn > alldir.out

6 Use your editor to open this newly created file and remove the following entries: 

sxadmin, sxqueryadmin, ScalixAdmins, ScalixUserAdmins, ScalixGrou-

pAdmins, ScalixUserAttribtesAdmins. 

These mailboxes either already exist (sxadmin and sxqueryadmin) or are mailboxes 
representing groups.

7 Run the original ommigu command with this new imput file, as shown here: 

ommigu –userfile alldir.out –m mailnode –p password –expire > 

ommigu.stdout 2> ommigu.stderr

8 Run the ommigu command, including the –raf option:

ommigu –userfile alldir.out –raf

The synchronization should now run without errors. 

Alert Don’t run the command in step 8 if the command run in step 7 results in errors.
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Important Note

Note that the omldapsync command does not report errors. Subsequent updates will not 
attempt to add a missing entry.  However, there are instances that require you to perform 
more labor-intensive tasks such as manually modifying a directory entry on the Exchange or 
Scalix Server. 

Scalix Corporation recommends that you change the target side of the directory synchroni-
zation to resolve conflicts. For example, if you are trying to synchronize a new Exchange 
user named “John Doe”, and the remote recipient with the same name already exists in 
Scalix Server, change the remote recipient entry to “John Doe1” (or something similar) and 
select option 3 (Update the directory after some changes) in the omldapsync menu. omlda-
psync should report no errors. If errors do occur after you successfully add the “John Doe1” 
entry in the Scalix Server directory, select option 4 (Accept previous error and update direc-
tory) in the omldapsync menu to ignore the error. 
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Task 4: Migrating Public Folder Data
to Scalix Server

This chapter covers the procedure for migrating public folder data from Exchange to Scalix.

Contents
This chapter includes the following information:

• “Requirements:” on page 64

• “Exporting Exchange Public Folder Data” on page 64

• “Importing Exported Data into the Migratable Folder” on page 67

Requirements:

If you have not already done so, create the two e-mail user profiles in the Windows Mail con-
trol panel that Outlook will refer to in this process:

• Scalix

• Exchange

Exporting Exchange Public Folder Data

To migrate the contents of a specific Public Folder to Scalix Server:

1 Using a “Microsoft Exchange” profile, start the Outlook Client.

This allows you to connect to the Exchange server as a Public Folder owner.

2 Choose File > Import/Export. 
64



Scalix Migration Guide | Task 4: Migrating Public Folder Data to Scalix Server
The Import/Export Window (for export) appears. 

3  Select Export to a File, and click Next.

The Export To a File wizard panel appears. 

4  Select Personal Folder File (.pst), and click Next.

The Export Personal Folders (Selection) wizard panel appears. 
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5 Navigate to the folder into which you copied the Exchange Public Folders that you 
want to migrate (“Clean and migrate”).

6 Make sure you check the Include Subfolders check box.

7 Click Next. The Export Personal Folders (Save As) wizard panel appears. 

8  Enter a name for the file (in the format “file_name.pst”) and specify a folder loca-
tion in which to save the file. 

9 Click Finish.

A dialog box appears 

10 If you have concerns about the vulnerability of your public folder data, enter a 
password for the .pst file.

11 Click OK to proceed.

12 A series of export status dialog boxes appears, representing the contents of each 
folder.

When the status dialog boxes cease, you can now import the .pst file to the Scalix 
Server. 

Note Write down the filename and location pathway for future reference (in the context of migra-
tion).
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Importing Exported Data into the Migratable Folder

To import the just-exported .PST files into Scalix:

1 Using a Scalix profile, start Outlook.

This allows you to log in as a public folder owner on the Scalix server.

2 In the folder list, select Public Folders.

3 Choose File > Import/Export. 

The Import and Export wizard appears. 

4 Select Import from Another Program or File, and click Next. 

The Import a File wizard panel appears. 

5  Select Personal Folder File (.pst), and click Next. 
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The Import Personal Folders wizard panel appears. 

6 Click Browse, and use the browse dialog box to locate and select the file that you 
created previously. 

7 Click the check box by Replace Duplicates with Items Imported.

8 Click Next. 

The Import Personal Folders wizard panel appears. 

9 Use the explorer view to locate and select the top-level folder (“clean and 
migrate”) that contains the Public Folder(s) you want to migrate.

10 Click the check box by Include Subfolders to enter a check mark.

11 Click the button by Import Items into the Current Folder.

12 Choose Mailbox - username from the pull-down menu. 

13 Click Finish.
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Task 5: Loading Scalix
Server Mailboxes

This chapter covers the procedure for converting Exchange directory entries to Scalix Server 
mailboxes via the command ommigu.

Contents
This chapter includes the following information:

• “Overview” on page 69

• “Provisioning a Single Mailbox” on page 70

• “Verifying the New Mailbox” on page 70

Overview

The actual Scalix Server migration process (outside of coexistence) initially requires that 
you convert Exchange directory entries to Scalix Server mailboxes. The principal tool is a 
Scalix-originated command, ommigu. This command specifically modifies Scalix Server 
directory entries that represent Exchange users. After omldapsync loads a Scalix Server 
directory with Exchange directory objects (such as mailboxes, custom recipients, distribu-
tion lists), the next step is to modify the objects so that they become mailboxes, ready for 
use or for data importation.

You must apply ommigu to all Scalix directory objects that will become local Scalix mail-
boxes. For example, if an organization has 10,000 Exchange mailboxes planned for migration 
onto two Scalix Servers (5000 users on each), you can now provision all 5000 users at this 
stage of the migration process. The unprovisioned 5000 users remain on the other Scalix 
server as directory entries that (respectively) reference (using a SMTP address) the original 
Exchange mailbox (similar to the period after the initial synchronization occurred using 
omldapsync).

The ommigu command converts each directory object to a full Scalix Server mailbox while 
excluding it from the omldapsync process. ommigu also creates auto-forwarding information 
in the mailbox so that mail addressed to a Scalix Server mailbox routes back to the respec-
tive Exchange mailbox (using an SMTP address). 
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Provisioning a Single Mailbox

To provision a single directory entry as a mailbox (to validate the process):

1 Log in to Scalix.

2 Open a terminal window and enter the following:

ommigu -n “Exchange Display Name” -m “Scalix mailnode of the user” 

-G 

The command arguments include the following:

• “Exchange Display Name” is the equivalent of the Scalix Server Common Name 
attribute.

• –G  generates a random password for the mailbox. 

• –p <password> lets you specify a specific password. 

• -expire force users to specify a new account password the first time they log in 
to Scalix Server. 

Here are some example mailbox-provisioning commands

ommigu –n “Forest Stevens” –m “xyzcorp,usa” –G

ommigu –n “Dave Johnson” –m “xyzcorp.usa –p 123456 –e

3 Use these two commands to assess the results in Scalix:

omsearch -e cn=*

(This will list the new mailbox by Common Name.)

omshowiam -m -ca=”exchange_display_name”

(This will list the attributes for the user.) 

Verifying the New Mailbox

To see if the new mailbox appears in Outlook:

1 Start Outlook, using a Scalix profile.

2 Set up an account for the new mailbox.

3 Log into that mailbox.

4 Choose Tools > Send/Receive. This will verify a connection to the server.

Note The mailbox should note the status of ‘unlocked”.
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Task 6: Reconfiguring Auto-Forward
for the New Scalix Mailboxes

This chapter covers the process for cancelling the auto-forward on Scalix mailboxes and 
then updating the Exchange directory via the synchronization command.

Contents
This chapter includes the following information:

• “Overview” on page 71

• “Removing the forwarding Address” on page 71

Overview

After provisioning the new Scalix mailboxes from the directory entries, do the following:

• Remove the forwarding (SMTP) address on Scalix Server mailboxes

• Allow the omldapsync command to update the Exchange directory

Both tasks can be accomplished with the CLI command, ommigu, as detailed here.

Removing the forwarding Address

To reconfigure auto forwarding:

1 Log in to Scalix.

2 Open a terminal window and enter the following:

ommigu -n “Exchange display name” --raf

This command removes the auto-forwarding to Exchange mailboxes

It also updates other mailbox settings to indicate that the mailbox is associated to a 
migrated user and is ready for use.

3 To run omldapsync in “interactive” mode, enter the following:

omldapsync -i syncid
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• Replace syncid with the actual agreement  name.

4 At the prompt, enter 3 to update the directory.

5 The results scroll on-screen.

6 When this task is complete, you are prompted to exit.
72



Task 7: Configuring Message Forward-
ing from Exchange to Scalix

This chapter covers the procedure for routing all new mail to Scalix.

Contents
This chapter includes the following information:

• “Overview” on page 73

• “Adding Alternate Recipient Information for a Single Mailbox” on page 74

• “Adding Alternate Recipient Information for Several Mailboxes” on page 75

Overview

At this point, you must configure Exchange to route all new mail messages to Scalix Server 
mailboxes. This enables you to migrate data from what are now legacy Exchange mailboxes 
without having new mail or other data reaccumulate in just-migrated Exchange mailboxes. 

To do this, you must configure an Alternate Recipient address for every Exchange mailbox 
you plan to migrate. The Alternate Recipient address routes messages originally destined for 
the Exchange mailbox to a different address—the Scalix Server mailbox. This alternate 
address must exist in the Exchange GAL.

The omldapsync command already added an Exchange custom recipient entry for each mail-
box in the current migration group. This custom recipient entry contains an SMTP address 
that routes to the Scalix Server mailbox. You must now record these custom recipient 
entries in Exchange as the alternate recipients for each mailbox. 

There are two methods you can use to add alternate recipient information in Exchange:

• One entry at time

• Multiple entries at one time

Each of these methods are detailed in this chapter
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Adding Alternate Recipient Information for a Single 
Mailbox

To add Alternate Recipient information for a single Exchange mailbox:

1 Start the Microsoft Exchange Administration application.

2 Open the Recipients list (or whichever list you’ve created) for your Exchange 
site.

3 Locate the first mailbox associated with a user you are migrating to Scalix Server, 
and double-click the entry.

The [username] Properties dialog box appears.

4 Click the Delivery Options tab. 

5 Click Modify (in the middle of the dialog box.)

The Mailbox [username] dialog box appears.
74



Scalix Migration Guide | Task 7: Configuring Message Forwarding from Exchange to Scalix
6 Make sure Global Address Files is selected in the upper-right menu.

7 Scroll through the left-hand column and find the directory entry with a Globe icon 
that has the same name as this user’s mailbox. 

8 Select this entry and click Add. 

The selected directory entry appears in the list column to the right.

9 Click OK to close the Mailbox dialog box.

10 When the Properties dialog box reappears, click OK to put the custom recipient 
entry into effect.

Adding Alternate Recipient Information for Several 
Mailboxes

Typically, the migration from Exchange to Scalix Server includes hundreds of users. There-
fore, adding alternate recipient information one mailbox at a time would be inefficient. 

Using the Exchange Import and Export tools in conjunction with modified output files, you 
can add hundreds of alternate recipients to existing Exchange mailboxes at the same time. 

1 Open the Exchange Administration application.

2 Choose Tools > Directory Export.

The Directory Export dialog box appears. 

3 To create a directory export file of Exchange mailboxes, make these entries:

• The default Exchange server and Home server names are acceptable.

• The default settings/selections in Export Objects, Logging Level, and Separators 
are acceptable.

• Do not check “Include Hidden Objects”.

• Click Export File.

Note There should be a listing for this user’s mailbox—with no icon—as well as a second listing 
with a globe icon—representing the custom recipient that routes incoming mail to this user’s 
Scalix mailbox.
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• When a dialog box appears, name this file and pick a target folder. 

• Enter a name that identifies the contents of the output file, and make sure the 
“.csv” extension is present.

4 Click Export to start the process. 

Modifying the Output File
Typically, you are migrating users in groups that are a subset of the container you specify in 
Step 3 above. Therefore, you must modify the output file so that it contains only the mail-
boxes to which you want to add alternate recipient information.

To modify the output file: 

1 Start Microsoft Excel.

2 Choose File > Open, and open the output file from your directory export. 

3 Choose File > Save As.

4 When the Save As dialog box appears, save this file with a different file name. 

5 Verify that the output file ends with column M, and that column N is empty.

6 In cell N1 (of column N), type “Alternate Recipient” as the column header. 

7 Save these changes.

Entering Custom Recipient Container and Alias Name Parameters
Before you modify the exported-directory output file in Excel, be aware:

• The output file displays the following string in Column E: 

/o=Organization/ou=Site/cn=Custom_Recipient_Container/

cn=alias_name

• The MS Excel output file displays the following string in Column L (the Obj-Container 
header): 

/o=XYZ/ou=XYZNA/cn=America

Using the Exchange Administration application, you can determine that omldapsync stored 
the custom recipients in the America-CR container.

To complete the alternate recipient entry process for your Exchange mailboxes:

1 With your exported directory output file open in Excel, enter the following string at 
the bottom of the spreadsheet (in the first empty row below all existing entries): 

/o=XYZ/ou=XYZNA/cn=America-CR/cn=

2 Enter a concatenation formula in cell N2 that adds the string from the static cell 
and the value in column E. For example, if you enter static data in cell A120, cell 
N2 must have the following formula:

=concatenate($A$120,E2)

Tip Write down the name and folder location of this file.
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3 Apply the same formula for all other entries in column N. Select (highlight) cell N2 
and press Ctrl + c to copy the contents. Highlight all the other entries in column N 
and press Ctrl + v to paste the contents. 

The text string that displays in the Alternate Recipient column contains four 
parameters (with delimiters).

/o=Organization/ou=Site/cn=Custom_Recipient_Container/

cn=alias_name

Here are the alternate recipient column parameters 

4 Verify the accuracy of the data, then choose File > Save As to save the file with 
a different name. Make sure you click Yes at the Retain the Format prompt. 

5 Choose Tools > Import > Select File to import the file into Exchange. 

You can use the default values for Account creation, Logging level, and Separators. 
The Container value is where the mailboxes (not the custom recipients) reside. 

Use the Exchange Administration application to check the properties of a sampling of mail-
boxes—especially the Delivery Options tab where an Alternate Recipient should appear.

Parameter Description

Organization Displayed in column L.

Site Displayed in column L.

Custom_Recipient_
Container

The container into which omldapsync inserted the Custom Recipient infor-
mation. Use the Exchange Administration application to obtain the name of 
the container.

alias_name

The Alias Name displays in column E, and the text string you enter in column 
N depends on the alias_name value.The rest of the string is identical for 
each cell. You can enter static information in a single cell and use the Con-
catenate function in Excel to combine the data from column E in the same 
row. 
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Task 8: Migrating Mailbox Data with
SMT

After you modify the Exchange server with Scalix Server mailbox information and provision 
the target mailboxes on the Scalix Server, you can begin migrating actual mailbox data. This 
chapter explains how to do that with the Scalix Migration Tool.

Contents
This chapter includes the following information:

• “Requirements” on page 78

• “Introduction” on page 79

• “Before You Begin” on page 79

• “Procedure Overview” on page 79

• “Extracting Microsoft Exchange Mailbox Data” on page 80

• “Copying .pst Files into Scalix” on page 83

• “Creating the Target Mailboxes” on page 85

• “Running the Migration Tool” on page 85

• “Additional Notes” on page 86

Requirements

• Scalix 10.0 or higher*

• Scalix Connect 10.0 or higher

• A Windows 2000 or XP-installed workstation with Service Pack 2

• Microsoft Office 2000 or XP

*For foreign-language mailboxes, migration can only take place with Scalix 11.0 or higher.
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Introduction

The Scalix Migration Tool is a command-line-based Windows application that moves mailbox 
data from the source server (Microsoft Exchange) to the destination server (Scalix) in a two-
part process:

• Using ExMerge to extract the mailbox data from Microsoft into .pst files. 

• Moving the data from the .pst files into Scalix. 

Migration is a read-only process that does not change mailbox contents in any way. The tool 
works by opening the source mailbox at root, and then traversing the folder hierarchy copy-
ing messages and other mailbox data from each source folder. Once the copy is done, the 
migration tool makes sure the new mailbox exists on the destination server, then pastes the 
contents into it. As it pastes the data, it updates any changes to internal email addresses 
that it encounters. These internal address updates are done according to the latest data in 
the LDAP server and are executed ONLY on the destination server. When it finishes with one 
folder, it moves on to the next until all mail folders have been copied over.

“Hidden messages” that store display data or other message parameters automatically 
transfer during this process. 

If the tool encounters a problem with a specific message or folder, it logs the information 
and continues with the migration until it is done. For that reason, it is essential that you 
review the logs after any migration to see what messages, if any, the tool skipped over and 
why. You can manually copy those messages over later if needed. 

Before You Begin

Before you begin mass extractions, try extracting one mailbox, then importing it in to Scalix 
to verify the process’ efficacy. Once a successful process is proven, you can undertake 
“batch” extractions.

Procedure Overview

A broad overview of the Scalix Migration Tool procedure includes:

1 Install ExMerge and configure it to extract .PST files from your Exchange environ-
ment.

2 Build (or use an existing) Windows XP machine, with Office 2003 installed, including 
Outlook 2003. This will be the migration workstation.

3 Create a directory on the migration workstation to run the tool from (C:\SMT is rec-
ommended), and save the sxmigrate.exe program in this directory.

4 Perform a few test mailbox extracts from the Exchange environment with 
Exmerge.exe, then copy these machines to the local drive of the Windows migra-
tion workstation, into the directory where sxmigrate.exe exists.

5 Create the target mailboxes on Scalix (use SAC or omaddu commands). 

6 Do a test run to load a few mailboxes. The mailbox must already exist on Scalix. 
Typically, Exmerge will name the .pst file with the RDN attribute of the given mail-
box. Once you get a clean migration, do the remainder as a batch process. 
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Extracting Microsoft Exchange Mailbox Data

The Microsoft Exchange Mailbox Merge Program (Exmerge.exe) enables an Exchange Server 
administrator to extract data from mailboxes on an Exchange Server. The Exchange Server 
5.5 version of this program is included in the Microsoft BackOffice Resource Kit, Second Edi-
tion. The Exchange 2000 Server version of Exmerge is included on the Exchange 2000 Server 
CD in the Support\Utils\I386\Exmerge folder. 

One of the options this tool offers is to write each user's mailbox data into individual .PST 
files. The Scalix Migration Tool can be used to then read each of the .PST files, and load the 
data into the users corresponding Scalix mailbox.   

To run the exmerge.exe program: 

1 At the Exchange server containing the mailboxes you want to migrate, run 
exmerge.exe. You get the welcome screen. Click Next.

2 At the next screen, select the Two step merge option and click Next.

Note If using exmerge, the export language should match the native language of the mailbox. If 
the two languages don’t match, string properties are exported incorrectly.
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3 At the next screen, select Copy data to Personal Folders and click Next.

 

4 At the next screen, enter the name of the Exchange server from which you wish to 
extract mailbox data and click Next. 

At this point, you can select the Options button, which provides additional filter-
ing capabilities against the mailbox data. For example you could base the amount 
of data extracted by dates.
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5 The next screen prompts for the mailboxes you want to merge. Choose specific 
mailboxes or all mailboxes.

 

6 At the next prompt, select the destination directory to write the.PST files to. 

At this point, you should also write the files to a network file share that will be 
accessible by the Windows PCs that will be used next to run the Scalix Migration 
Tool.
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7 The final screen shows a progress bar and ultimately completes, after which you 
can click Finish.

8  At this point the .PST files will have been created in the target directory specified 
on the prior screen. 

Copying .pst Files into Scalix

Once all Exchange data has been extracted into .pst files, you can use the migration tool to 
copy the data over to Scalix.
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The sxmigrate Command and its Parameters
The basis of the migration tool is the command, sxmigrate. An example of this command 
would be:

sxmigrate –s pst:///c:/test/mailbox.pst –d “scalix://Test User:pass-
word@<fqdn>” –dir ldap://<fqdn>/cn=users,dc=Scalix,dc=local?mail –
dirauth <username>@scalix.local:password1

This command can take several parameters or switches:

* In the Scalix Migration Tool, the -s, -d, -dir parameters all use URLs as locators. The form 
the URL takes can vary. Here are several examples:

• For the source .pst file: –s pst:///c://test/mailbox.pst 

This specifies the source mailbox as the .pst file located in c:\test\mailbox.pst. The 
mailbox is specified as a .pst URL. Notice the three slashes - the first two are part of 

Table 1: Parameters or Switches for the sxmigrate Command

Parameter 
or Switch

Definition

-s Use this parameter to designate the source mailbox. The mailbox location 
should be expressed in the form of a URL *

-d Use this parameter to designate the destination mailbox. The mailbox loca-
tion should be expressed in the form of a URL.*

-dir

Use this parameter to designate the location of the LDAP directory that SMT 
should refer to when updating any changes to internal email addresses that it 
encounters during migration. This LDAP directory may be the Exchange AD 
directory, the Scalix SYSTEM directory or any suitable directory that can pro-
vide the old email address information and the new email address informa-
tion.
The LDAP directory location should be expressed in the form of a URL*

-diroff
Use this parameter to designate the credentials to access the LDAP direc-
tory if needed. This parameter is optional because some directories require 
credentials while others do not. Many can be accessed anonymously.

-log Use this parameter to designate the path and filename for the log file

--copy Copies mailbox data over to the destination server without the additional 
updating of internal email addresses

--fixup Updates internal email addresses without copying the data over to the desti-
nation server

--ex55 Tells the migration tool that the source data is coming from Microsoft 
Exchange 5.5

--noui Suppresses the UI
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the URL spec, the third is to specify an empty or non-existent hostname. Also notice 
the use of forward slash in the URL instead of backslash.

• For the destination Scalix server: –d “scalix://Test User:password@stin-
gray.scalix.com” 

This specifies the destination mailbox as the Scalix mailbox “Test User” located on the 
server stringray.scalix.com. The password for the mailbox is defined as “password” 
and follows the mailbox name after a colon character. Again, this is consistent with 
the URL RFC.

• For an LDAP server: –dir ldap://exchang1.scalix.com/
cn=users,dc=Scalix,dc=local?mail 

This specifies the directory to use for directory fixup. In this example, the source 
exchange directory is used because the SMTP address will not change as a part of this 
migration. This method has no additional requirements on the Scalix server. If the 
Scalix directory is to be used, then a new attribute must be synchronized over from 
the source exchange directory (typically proxyAddresses à omLegacyEmailAddresses). 

This is an LDAP URL, the server name is exchange1.scalix.com. The DN to the user root 
is cn=users,dc=Scalix,dc=local (in our example server) and the attribute to use is the 
mail attribute. See an example of a Scalix server in the help screen. If a –dir parame-
ter is provided, then it is assumed that if the destination mailbox is a Scalix mailbox, 
the Scalix directory will be used (equivalent to specifying on the command line “-dir 
ldap://stingray.scalix.com/o=Scalix”omLegacyEmailAddress” 

Creating the Target Mailboxes

Once you have performed a few test mailbox extracts from the Exchange environment with 
ExMerge.exe and have copied these to the local drive of the Windows migration worksta-
tion, you can move on to the next step. Remember that the .pst files must be copied into 
the directory where sxmigrate.exe exists.

The next step is to create the target mailboxes on Scalix. For this, use the Scalix Manage-
ment Console. For more on how to create mailboxes in the SMC, see the Scalix Administra-
tion Guide. If you want to use the command line, use the omaddu command, which also is 
covered in the Administration Guide.

Running the Migration Tool

After creating the target mailboxes, the next step is to execute the sxmigrate program. 
Because the specifics of the commands you use will vary according to your own, unique 
setup, we provide only a sample command line.

Note Running sxmigrate.exe displays the tool’s help screen.

Alert If you are migrating from Microsoft Exchange 5.5, you must include the -ex55 parameter.
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.

To migrate users with the Scalix Migration Tool:

1 Download the tool on the Windows migration workstation (in C:\SMT or something) 
and unzip.

2 Run several test mailbox migrations individually. The mailbox must already exist on 
Scalix. Typically Exmerge will name the .pst file with the RDN attribute of the 
given mailbox (ldapsearch it - you'll see). 

An example command line is.

C:\SMT>sxmigrate -s pst:///c:\smt\rdn.pst -d "scalix://Bart 

Jones:mailpass@sxserver.abcco.com"

 -dir "ldap://exserver.abcco.com/cn=Recipients,ou=Chi-

cago,o=ABCco?mail" -dirauth "cn=exservice":Pa$$w0rd 

 --ex55

Where:

• The name of the .PST file created by exmerge.exe is rdn.pst

• The Scalix User Account (Common Name) is Bart Jones, whose Scalix password is 
mailpass

• The Scalix server FQDN is sxserver.abcco.com

• The Exchange server FQDN is exserver.abcco.com

• The Exchange organizational hierarchy is cn=Recipients,ou=Chicago,o=ABCco

• Exchange SMTP addresses are loaded in the "mail" attribute (sometimes 
rfc822Mailbox is used here).

• Exservice is an account in Exchange that has "service account" privileges on all 
levels of the hierarchy (the Administrator account can also typically be used), 
with a password of Pa$$w0rd. 

3 Once you’ve successfully migrated several individual mailboxes, try a small batch.

4 When that succeeds, try a larger batch.

Additional Notes

A few additional things to keep in mind when using the Scalix Migration Tool:

• Typically Exmerge.exe creates the .pst file names with the RDN attribute of the given 
mailbox.

NOTE This procedure does not support cross-system Free/Busy retrieval. So if one user is still on 
Exchange and another user has been migrated to Scalix, you will see valid Free/Busy information 
for the second user once Outlook or SWA has published it. But you will not see it for the first user. 
In addition, only Outlook or SWA publishes Free/Busy information for Scalix. This must be done 
once a user has been migrated or they won't display as having any Free/Busy information.
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• You can use ldapsearch from a Linux host just to make sure you get the search base 
and hierarchy that are correct against the Exchange environment, and also reveal the 
RDN of each object.

• You can use multiple migration workstations running in parallel. 

• While the 10.0.x builds of Scalix Connect can be used, it is best to use Scalix Connect 
(11.x).
87



Task 9: Decommissioning the
Exchange Mailboxes

This chapter explains how to deactivate the Exchange mailboxes, preventing them from 
being accessed by their users without deleting them.

Contents
This chapter includes the following information:

• “Decommissioning Mailboxes One at a Time” on page 88

• “Decommissioning Multiple Mailboxes at a Time” on page 89

When you complete the migration of all the mailboxes (including mailbox data), you can 
decommission the Exchange mailboxes. This process makes them unusable without deleting 
them. Since a custom recipient of the same name already exists in the GAL, you can hide 
the Exchange mailboxes without adversely affecting the system. 

Decommissioning Mailboxes One at a Time

To decommission a single mailbox:

1 Start the Exchange Administration application.

2 Open the container (by default, “Recipients”) containing the migrated mailboxes.

3 Double-click any mailbox entry, to open the Properties dialog box.
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4 Click the Advanced tab. 

5 Click the check box by Hide from Address Book (as highlighted above).

6 Click OK to save the change and close the dialog box.

Decommissioning Multiple Mailboxes at a Time

To simultaneously decommission (hide) a number of Exchange mailboxes:

1 Open the backup file you created previously.

2 Verify that Column M contains a header named Hide from AB (address book) and 
has a value of “0” (zero). 

3 Change the value in column M to “1”.

4 Save the file.

You can now import the file into Exchange:

1 Start Exchange Administration.

2 Choose Tools > Directory Import.
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The Directory Import dialog box appears. 

3 Choose from the following options.

• Click Import File and use the dialog box to locate and open the Excel file.

• Use the default values for Account Creation, Logging Level, and Separators. 

• The Container value indicates where the mailboxes (not the custom recipients) 
reside.

4 Click Import.

A status dialog box appears, and closes when this task is complete. 

Verifying the Decommissioning
1 Start the Exchange Administration application—or the Outlook client.

2 Verify that the mailboxes are no longer visible in the Exchange GAL.
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Task 10: Post-Migration and Coexist-
ence Closure Tasks

This chapter outlines the tasks needed to end coexistence between Scalix Server and 
Exchange, and complete the migration of Exchange users and data to Scalix Server.

Contents
This chapter includes the following information:

• “Managing Distribution Lists” on page 91

• “Scalix Server Distribution List Synchronization” on page 92

• “Managing Distribution Lists from Exchange” on page 92

• “Switching Distribution List Management to Scalix” on page 92

• “Switching PDL Management After Coexistence” on page 97

Managing Distribution Lists

As a phased migration proceeds, one serious question arises: how to coordinate Distribution 
Lists. Some recipients on a Distribution List still reside in the old environment (Exchange) 
while some recipients are migrated to the new environment (Scalix Server). 

If you delete Exchange mailboxes (after successful migration to Scalix Server), any alternate 
recipient information (referencing the new Scalix Server mailbox) will be removed from all 
Exchange Distribution Lists. If this poses a problem, you can manually insert the reference 
to the Scalix Server mailbox back into all Exchange Distribution Lists to which the just-
migrated users belong. 

However, during the migration process, Scalix Server provisions directory entries as mail-
boxes with automatic redirection instead of redirection-only entries. The benefit of provi-
sioning entries in this manner is that it enables the option of mirroring the structure and 
members of Public Distribution Lists on Scalix Server at anytime. As users are migrated from 
Exchange to Scalix Server, you do not have to delete and add the directory entry into the 
list. Similarly in the Exchange environment, the management of Distribution Lists during the 
migration to Scalix Server is simplified because you do not have to remove mailboxes. 

Although you eventually add (and hide) alternate recipient information to Exchange mail-
boxes, you do not need to remove mailboxes and replace them with custom recipients dur-
ing the migration process.
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Scalix Server Distribution List Synchronization

Exchange objects that are either custom recipients or mailboxes (that eventually reside on 
the Scalix Server) are classified as remote recipients by Scalix Server. All Exchange Distribu-
tion Lists become Scalix Server Public Distribution Lists (PDL’s) and all Distribution Lists are 
configured to automatically forward to the SMTP address of the respective Exchange Distri-
bution List.

Managing Distribution Lists from Exchange

After you execute the omldapsync and ommigu commands, create a test account on Scalix 
Server to validate Distribution List routing. A message addressed to the Scalix Server PDL 
from the test account should be delivered to the recipients on the PDL. The message should 
also deliver a copy of the message to the respective Exchange Distribution List, where it is 
then delivered to the respective recipients of the Exchange Distribution List. In this sce-
nario, a single message is routed from Scalix Server to Exchange, where it is then dispersed 
to the recipients, none of which reside in the Scalix Server environment at this point of the 
process.

Switching Distribution List Management to Scalix

You can switch Distribution List management from Exchange to Scalix either during the 
coexistence period or after coexistence. This requires the creation of an Exchange Custom 
Recipient entry with the Internet address of a specific Scalix Server Public Distribution List 
and a unique display name (for example, SALES-PDL).

To switch distribution list management to Scalix:

1 Create a custom recipient pointing to the Scalix group: In Exchange Administrator, 
choose File / New Custom Recipient.

The New Email Address dialog box appears. 
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2 Select Internet Address and click OK. The Internet Address Properties DB 
appears. 

3 Click in the Email Address field and type the Scalix group's full email address.

E.g, “sales-pdl@mailserver.scalix.company.com”

4 Click OK to proceed.

The Properties DB appears. 

5 Click in the Display field and type the Scalix group's name (probably the same 
name as the original Exchange PDL).

6 Click in the Alias field and type the scalix group's full email address.

• Ignore all the other fields.

7 Click Apply, then click OK, to close this dialog box and save your entries.
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8 When Exchange reappears, open the Lists menu and choose Custom Recipi-
ents. 

The new custom recipient should appear in the now-visible list.

9 Remove the Exchange auto-forward from the Scalix Group/Public Distribution List 
that refers to the original Exchange Public Distribution List.

10 Set up the auto-forwarding for the Exchange group: In Exchange Administrator, 
double-click the original PDL entry to open that list’s Properties dialog box. 

11 Click the Modify button below the Users list (as highlighted above). 
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The Distribution List [Name] dialog box appears. 

12 Select and delete all the entries in the Distribution List Members list (as 
highlighted above). 

13 In the same dialog box, locate the custom recipient (representing the Scalix group). 

14 Select it and click Add ->.

15 Click OK to save the change and close the dialog box.

16 When the Properties dialog box reappears, click Apply, then click OK to save your 
changes.

17 Now hide the custom recipient from Exchange view: Start Exchange Admin.
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18 Open the List menu (in the Exchange Administrator toolbar) and choose Custom 
Recipients. 

19 Locate and double-click the Scalix-group custom recipient in the list that appears.

20 When the [RecipientName] Properties dialog box appears, click the Advanced 
tab. 

21 In the Custom Recipient Options, click the check box by Hide from address 
book (as highlighted above).

22 Click Apply to activate your changes, then click OK to close the [RecipientName] 
Properties dialog box.

23 You can exit Exchange Administrator.

What happens?
Any remaining Exchange users can address messages to the same Exchange-based Public Dis-
tribution List that now has only one member—the custom recipient that contains the Inter-
net Address of the corresponding Scalix Server Public Distribution List.   

You can now switch administration of this distribution list (including additions or deletions 
of recipients) to the Scalix Server copy.
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Switching PDL Management After Coexistence

If you switch Distribution List management after coexistence (when there are no more 
actively used mailboxes on Exchange), you must add all relevant users to the Scalix Server 
Distribution List in one of two ways:

• Using the Web Administration client

• Open a terminal window (CLI) and run the omaddpdln command

Adding a number of names to a Scalix Public Distribution List can be made more efficient by 
extracting the original Exchange recipient list to a convenient text file, then formatting the 
file for importation into Scalix.

Copying the PDL from Exchange
1 In Microsoft Exchange Server Administrator, open the Recipients container where 

the Public Distribution Lists are stored. 

2 Right-click the appropriate Public Distribution List entry and choose Properties.

The [ListName] Properties dialog box appears. 

3 In the General tab, click Modify.
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A Distribution List [name] dialog box appears. 

4 Select all of the list’s users (by clicking in the Members list and pressing Control-A) 
and copy them to the Windows clipboard.

5 Close the Distribution List and Properties dialog boxes.

6 Open a new Notepad or Wordpad document and paste the collection of users into 
the document window. 

7 Save this document as Dlist.txt.

8 You can exit Exchange Administrator.

Formatting theList File for Importation
To process this text document in Microsoft Excel for use in Scalix:

1 Open a new Excel workbook.

The active cell should be A1. 

2 Choose Data > Import External Data > Import Data
98



Scalix Migration Guide | Task 10: Post-Migration and Coexistence Closure Tasks
The Select Data Source DB appears. 

3 Locate and select the user names text file.

4 Click Open. 

The Text Import Wizard appears. 

5 In Text Import Wizard 1/3, click the Delimited button.

Tip: take advantage of the “preview” pane in the lower half of this dialog box to 
verify your text file's contents.

6 Click Next.
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The Text Import Wizard 2/3 appears. 

7 Click the Delimited check box. (Make sure this is the only active selection. 
Uncheck any others.)

8 Make sure that both first and last names are sorted into the same cell/column as 
shown in the preview area of this dialog box.

9 Click Next.

The Text Import Wizard 3/3 appears. 

No changes are needed. 

10 Click Finish.
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The Import Data dialog box appears. 

11 Click OK. (The default location should be the current worksheet, in cell =$A$1)

Row 1 should display names from the list, one first/last name pairing per cell. 

12 Select the entire row. (Selecting empty cells does not affect this procedure.)

13 Copy the row’s contents to the Windows clipboard.

14 Open a new Excel workbook.

(Cell A1 is auto-selected.)

15 Choose Edit / Paste Special

The Paste Special dialog box appears. 

16 Click the check box by Transpose. (All other default settings are OK.)

17 Click OK to complete the pasting of data. 
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Excel redistributes the first and last names in Column A. 

18 Due to the default column width, the name entries may appear to spill into column 
B, and maybe C. Widen Column A (as shown above) to verify that each first/last 
name entry fits in its own Column A cell.

19 Save this file/workbook as a text file for importation into Scalix.

20 Print the file.
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Task 1: Activating Auto-Forwarding on
Microsoft Exchange

This chapter covers the first “official” migration task, which is to activate Auto-Forwards on 
the Exchange Internet Mail Server. During the coexistence period, mail will be routed from 
an Exchange server using Exchange Internet Mail Service (IMS) to a Scalix Server within the 
same internet domain, by means of the auto-forwarding.

Contents
This chapter includes the following information:

• “Requirements” on page 104

• “Activating auto-forwarding on Exchange” on page 105

Requirements

Before starting this task, you must have completed the following:

• Activated an Exchange server administrative user account (login)

• Installed and fully configured a working Scalix server

• Completed the DNS setup (for host.domain.extension) for the Scalix server

• Opened a shell terminal as root on the Scalix server 

• On your migration Windows workstation (with access to both Scalix and Exchange serv-
ers), create the needed e-mail user profiles (using the Windows Mail control panel). 
There must be one for “Exchange” and one for “Scalix”, that have the proper settings. 
See the Installation Guide for your Scalix system for specific instructions on creating a 
Scalix profile.

• You must also create an Exchange container to which you will import Scalix mailboxes.

Alert The DNS setup is critically important. If your Exchange server is registered as (for example) 
“company.mail.com” then you will need to assign the Scalix server a distinct DNS record, 
such as “company.scxmail.com”.
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Activating auto-forwarding on Exchange

To activate auto-forwarding on an Exchange server: 

1 Start the Microsoft Exchange Administrator application.

2 Select the site to be migrated, and then choose File > New Other > Recipients 
Container. 

A blank Properties dialog box appears. 

3 Enter a name for the new recipient container (for example, Scalix Mail Users) in 
both the Display name and the Directory name fields.

Note the new name appears in the dialog box and the title bar.

4 Click OK.

After a brief pause for processing, the new container name appears in the Exchange 
Administration explorer view. 

5 In the main Exchange Administration window, click the Connections button in the 
toolbar. 
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The explorer view expands, to show “Connections”. 

6 Click the Connections node in the explorer view.

7 Double-click Internet Mail Service in the listing to the right. 

The Internet Mail Service dialog box appears.

8 Click the Internet Mail tab, if it’s not already in view.

9 Click E-Mail Domain.
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The Email Domain dialog box appears. 

10 Click Add.

The Add E-Mail Domain window appears. 

11 Click in the E-Mail Domain field and enter the fully qualified domain name 
(host.domain.ext) of the destination Scalix server. 

12 Click Advanced Options. 

The Advanced Options dialog box appears. 

13 Open the Send Microsoft Exchange Rich Text Formatting pull-down menu and 
select Always. 

14 Remove the check mark in the Disable Automatic Replies to the Internet field. 

15 Click OK to close this dialog box. 
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16 Click OK to close each of the other currently open dialog boxes/windows.

An alert dialog box appears, prompting you to restart the Internet Mail Service.

17 Click OK to close this dialog box.

Stopping and Restarting the Exchange Internet Mail service
1 Open the Services control panel (Choose Start > Settings > Control Panel > Ser-

vices).

The Services control panel appears.

2 Locate and select the Microsoft Exchange Internet Mail Service.

3 Click Stop.

4 Leave the Services control panel open, and, after the “Started” notation is erased 
from Exchange, restart the service by selecting the name and clicking Start.

This completes the activation of auto-forwarding.
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Task 2: Preparing the Exchange Users
Distribution List

This chapter describes how to create a distribution list that includes all Exchange users in 
the environment. This list is used during the Public Folder coexistence and migration pro-
cess.

Contents
This chapter includes the following information:

• “Creating the Exchange Users Distribution List” on page 109

Creating the Exchange Users Distribution List

To prepare the Exchange users distribution list:

1 On the Exchange server, start the Microsoft Exchange Administrator application. 

2 Select a container that contains Exchange users you want to migrate. 

3 Select File > New Distribution List.

Note The default selection/container is “Recipients”.
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A blank Properties dialog box appears.

4 Enter “Exchange Users” in both Display name and Alias name fields.

5 Click Modify in the Members area. 

A Distribution List dialog box appears. 

6 Select all the Exchange users in the Global Address List field (left column) and click 
Add.

The selected names should all appear in the right column “Distribution List Mem-
bers” field (in a “text-only” run-on list). 

7 Click OK to close this dialog box and save your entry. 

Depending upon the number of users in your system, this may take some time to 
complete.

8 Click OK to close each of the remaining Exchange Administration dialog boxes. 
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Task 3: Configuring a TNEF route
for Exchange Users

This chapter covers the configuration of the Transport Neutral Encapsulation Format (TNEF) 
route, which enables Exchange recipients in the Scalix environment.

Contents
This chapter includes the following information:

• “Overview” on page 111“Overview” on page 111

• “Configuring TNEF Routes” on page 111

Overview

Scalix Server uses the Sendmail message transfer agent (MTA) and SMTP to route messages 
between servers. To configure Scalix Server for coexistence, you must configure a TNEF 
route on Scalix Server for the Exchange recipients in the Scalix Server directory. When LDAP 
synchronization occurs, the Exchange recipient entries are assigned to a Scalix Server mailn-
ode that corresponds to the omAddress value in sync.cfg file. By default, the omAddress 
value in sync.cfg file is set to remote,tnef.

Configuring TNEF Routes

To configure a single route between the Exchange server and the Scalix Server (with 
TNEF encoding):

1 Log in to the Scalix Server, and open a terminal window.

2 Enter this command:

omshowrt -q all

A table appears, showing the existing routes on the Scalix server. This table is orga-
nized in three columns—Queue - Mailnode - Format.

ALERT If you route messages directly between Scalix Server and Exchanges servers during coex-
istence, message formatting is downgraded to plain text. 
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LOCAL mailnode

UNIX internet MIME

UNIX internet,tnef TNEF

3 Enter this command: 

omaddrt -m <route_name> -q unix -i tnef 

(Replace the “<route_name>” entry with a name of your own choosing that repre-
sents this new route.) 

This new route uses the SMTP queue while retaining all TNEF attributes.

A confirmation message appears:

omaddrt: Route successfully added.

4 To verify the existence and content of the route, enter this command:

omshowrt -q all

The routes table reappears, listing your new entry (highlighted in Bold):

LOCAL mailnode,mailnode

UNIX internet MIME

UNIX internet,tnef TNEF

UNIX <route_name> TNEF 

5 To verify the route configuration, enter this command:

omshowux

A list of configurations appears, as shown here:

MIME Mailnode : internet

TNEF Mailnode : internet,tnef

TNEF Domains : 

Dist List Abbreviation Limit: 0 

6 Make sure that internet,tnef is listed as the TNEF Mailnode attribute. This ensures 
that TNEF routing is enabled. 

7 To list and verify the mailnodes that route mail to the UNIX queue for SMTP deliv-
ery, enter this command:

omshowrt -q unix

8  A table appears, listing mailnodes and formatting:

<route_name> TNEF

Alert Write down the new route name, as you will need it in future steps.

NOTE TNEF routing also supports domain-based encoding. See the man pages for omconfux and 
omshowux for more information.
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internet MIME

internet,tnef TNEF

9 To verify the routing configuration, send a test email message to both of the fol-
lowing:

• From a Scalix server user to an Exchange user

• From an Exchange server user to a Scalix user

For example, send a message from an address in this format:

sxadmin@mailnode.domain.ext 

to an address in this format:

exchange_user@domain.ext.

If the message exchange is successful, the route configuration is complete.
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Task 4: Fine-tuning LDAP on the
Scalix Server

This chapter covers the optional step of find tuning the LDAP server for higher numbers of 
users. If you are migrating more than one thousand user mailboxes from the Exchange server 
to Scalix Server, you must modify a key LDAP setting on the Scalix Server to increase the 
default capacity. 

Contents
This chapter includes the following information:

• “Fine Tuning LDAP” on page 114

Fine Tuning LDAP

To change this setting:

1 Log in to the Scalix server as root.

2 Use an editor to open this configuration file:

~/sys/slapd.conf

The configuration file contents appear.

3 Look for and change the size limit values, shown in bold text in the following exam-
ple of an sldap.conf file. 

Increase the size limit values large enough to extract all entries in the Exchange 
directory to the Scalix Server. If the migrateable mailboxes number 1,800, replace 
“1000” with “2000” (to allow for increases during the phased migration.)

database om    

suffix "o=MyContacts"    

flatSuffix "o=MyContacts"    

directory _MYCONTACTS_    

sizelimit 1000    

timelimit 15    
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useDit false    

#    

database om    

suffix "o=Scalix"    

flatSuffix "o=Scalix"    

#directory SYSTEM    

sizelimit 1000    

timelimit 15    

useDit false    

#    

database om    

suffix ""    

flatSuffix "o=Scalix"    

#directory SYSTEM    

sizelimit 1000    

timelimit 15    

useDit false  

4 Save any changes you made to the slapd.conf file.

5 To restart this service, enter this command:

omoff -a slapd

6 Wait approximately one minute and enter:

omon -a slapd

The LDAP service reconfiguration is now in effect.
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Task 5: Creating the
Synchronization Agreement

This chapter covers the synchronization agreement needed to provision users on the Scalix 
system based on pre-existing user records on the Exchange server.

Contents
This chapter includes the following information:

• “Requirements” on page 116

• “Completing a Synchronization Agreement” on page 118

• “Using the Sync Command to Create the Agreement” on page 118

• “Resolving Error Messages” on page 122

Requirements

There are two requirements before beginning this procedure:

1 Collect the required information:

• Domain name or IP address of the source Exchange server

• The password for the Exchange administrator user account

2 Pre-configure “Service Account Admin” rights/permissions for the Administrator 
account (in Exchange) that you want to use for coexistence with Scalix. This is 
detailed in the next section.

To Add “Service Account Admin” rights to an existing user:

1 Start Exchange Administrator. 

2 Click the relevant mail site name.

3 Choose File > Properties. 
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4 When the [Name] Properties dialog box appears, click the Permissions tab. 

5 Click Add.

The Add Users and Groups dialog box appears.

6 Open the List Names From menu and choose the relevant server name.

7 In the Name list, select the relevant administrator or admin group name.

8 Click Add. 

The selected name should appear in the Add Names field below.

9 Click OK to close the Add Users and Groups dialog box.

10 If a Permissions/Domains confirmation dialog box appears, click OK to close it.

The [name] Properties dialog box reappears.
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11 Open the Roles menu and choose Service Account Admin. 

12 Click Apply, then click OK to save this new permission state and close the [name] 
Properties dialog box.

Completing a Synchronization Agreement

Before starting the agreement, you must obtain the Exchange values for the omldapsync “a” 
attribute from the Exchange server. 

To find and note down these values from the Exchange server:

1 Open the Microsoft Exchange Administrator application. 

2 Select the site container that you are synchronizing.

3 Double-click any of the current user accounts.

4 When the [Name] Properties dialog box appears, click the E-mail Addresses 
tab.

5 Note the following X.400 values for the following fields:

C= country

P= organization

O= <your_site>

6 Write down this information and have it ready for use in the following procedure.

Using the Sync Command to Create the Agreement

To configure a synchronization agreement for the Exchange-to-Scalix migration:

1 Log into Scalix Server as root.

2 To execute omldapsync in “interactive” mode, enter this command: 

omldapsync -i syncid

• Replace syncid with a name for your Exchange-Scalix migration synchroniza-
tion agreement. The name should be no more than six alphanumeric characters 
in length. For example, Ex2Sx.

3 When the omldapsync menu appears, enter the number 1 at the prompt.

The omldapsync command determines that this is the initial directory synchroniza-
tion and creates the subdirectory for the synchronization agreement along with the 
sync.cfg file. 
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4 When omldapsync displays this prompt:

INPUT: Select sync agreement type to create (00):

5 Enter 00 (two zero’s) to specify that you are synchronizing with an Exchange 5.5 
server. 

6 When omldapsync displays this prompt:

Edit config file now y/n (n)

Enter y.

7 When omldapsync displays this prompt: 

Use vi to edit y/n (n) 

Enter n.

8 When omldapsync displays the following information:

# PART 1 General Configuration

##################################################################

. . .

EX_HOST[]:

Enter the fully qualified domain name or IP address of the Exchange server at the 
EX_HOST prompt. Use this format for the entry:

server.domain.ext

• The EX_ variable indicates an export from the Exchange server.

9 When omldapsync displays the following prompt:

EX_LOGON[Export Admin]:

Enter the Exchange Administrator account user name. 

10 When omldapsync displays the following prompt:

EX_PASS[]:

Enter the Exchange administrator password.

This password automates the entire migration process. If you do not enter the pass-
word at this time, omldapsync prompts you for a password every time you run the 
command. If security is a question, the password is saved in the sync.cfg file and is 
protected by the security policies configured for the Linux host system on which 
Scalix Server operates. 

11 When omldapsync displays the following information:

# PART 1.2 for IMPORT/EXPORT - local host

#########################################

NOTE After you are familiar with the synchronization agreement process and the VI editor, you can 
enter y at the Use vi to edit y/n (n): prompt if future configuration changes are needed. For 
the initial configuration, enter n so that the omldapsync command can step you through con-
figuration of the sync.cfg file. 
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. . . 

IM_LOGON[Import Admin]:

Enter the Scalix Server administrator user name. 

12 When omldapsync displays the following prompt:

IM_PASS[]:

Enter the Scalix Server administrator password.

As noted previously, entry of the password at this point automates the entire 
migration process. 

13 When omldapsync displays the following information:

# PART 1.3 for IMPORT - ldap parameters

#######################################

. . .

EX_BASE1[cn=recipients,ou=your_site,o=your_org]:

Enter the Exchange Global Address List (GAL) container. The entry should be in the 
following format:

cn=container name,ou=site,o=organization

This parameter defines the Exchange GAL container, where “cn” defines the name 
on the GAL container (that you want to migrate), “ou” defines the Exchange 5.5 
site, and “o” defines the name of the organization (domain). You can specify up to 
three containers using the subsequent prompts (EX_BASE2 and EX_BASE3)—but only 
if you have more than one container. If not, EX_BASE is sufficient.

14 When omldapsync displays the following information:

IM_OMADDRESS[/remote,tnef]:

Enter the TNEF route name you configured previously (in “Task 3: Configuring a 
TNEF route for Exchange Users” on page 111). 

15 When typing the route name, type only the name (not the “tnef” text) and be sure 
to enter a “/” preceding the name. For example:

/route_name

16 When omldapsync displays the following:

# PART 1.4 for EXPORT - ldap parameters

#######################################

IM_LOCAL_DOMAIN[@scalix_server.your_domain.com]:

Enter the domain portion for the Scalix Server SMTP address of the user. 

Your entry should be in this format:

@scalixserver.domain.com

Alert Enter just the user name, NOT the “@domain” texts.
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The parameter for this command is configured as the local mailnode domain. 
Because message routing already exists for the Exchange system, Scalix Server is 
configured to coexist alongside the Exchange mail system without having to modify 
the message routing topology. This requires that you use @scalixserver.domain.com 
format for this command. Although entries that Scalix Server imports to Exchange 
use this format, the external address of a user remains name@domain. (This should 
have been part of the pre-requisite setup.)

17 When omldapsync displays the following prompt:

EX_DN_SUFFIX[cn=ldapsync-

sync_agreement_name,ou=your_site,o=your_org]

Enter the location for the exported entries. 

• The container name (cn=) should be the name that you previously created for 
Scalix users in “Task 1: Activating Auto-Forwarding on Microsoft Exchange” on 
page 104. 

18 When omldapsync displays the following prompt:

EX_TEXT_EOA[c=US;a= ;p=your_org;o=your_site;]:

Enter the address where the entries are to be exported. 

For example:

c=country;a= ;p=yourorg;o=yoursite;

• Enter the X.400 value you previously noted down from Exchange (as detailed 
earlier in this chapter) for the a= attribute.

19 When omldapsync displays the following information:

# PART 2 Mapping Configuration

#################################################################

. . .

# END

#################################################################

Result=0

INPUT: Compare old config with new y/n (n): 

Enter y at the prompt.

20 When omldapsync displays the following prompt:

INPUT: Replace old config with new y/n (?): 

Enter y at the prompt.

21 When omldapsync displays the following information:

INPUT: Attempt to test data extraction now y/n (n):

Enter y at the prompt.

Output similar to the following (for an example agreement named “sa1”) should 
appear on-screen: 
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INFO: test searching from bamex55.bamail.net ... 

INFO: search base is cn=Recipients,ou=BAMUS,o=bamail

INFO: ... test searched OK. 

INFO: test searching from localhost ... 

INFO: search base is o=Scalix 

INFO: ... test searched OK. 

STATUS: Configuration of sa1 completed ########

This completes the agreement setup process.

Resolving Error Messages

If any WARNING or ERROR messages appear during this procedure, verify the synchronization 
agreement file.

To verify the sync agreement file:

1 While logged into Scalix, enter this command:

omldapsync -i syncid 

Replace syncid with the name of the Exchange-Scalix migration syn-
chronization agreement. 

2 When the omldapsync menu appears, enter 1.

3 The verification results scroll on screen, and at the end, you will be prompted to 
exit.

Reminder...
In the omldapsync interactive command menu, the following options are available:

• “1” allows you to simultaneously create and configure a sync agreement. If an agree-
ment doesn’t exist for the name you enter, omldapsync creates the needed directory 
structure and corresponding files.

• “2” lets you perform the initial sync of XS and SX directories.

• “3” Synchronizes the directories on the Scalix Server and Exchange servers by compar-
ing the current export file (which is created by selecting this option) with the previous 
export file. The omldapsync command adds, deletes, and modifies entries in the 
appropriate directory.

For more information on omldapsync commands, see “Guide to Synchronization Commands” 
on page 189.
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Task 6: Completing the Initial
Directory Synchronization

This chapter covers the procedure to complete the intial directory synchronization between 
Exchange and Scalix, which is done after you finish creating the synchronization agreement. 
As with the agreement procedure, you execute the omldapsync command in interactive 
mode and enter the Exchange-Scalix synchronization ID you previously configured. 

Contents
This chapter includes the following information:

• “Overview” on page 123

• “Synchronizing the Directories” on page 123

• “Managing Errors” on page 124

• “Important Note” on page 125

• “Resetting after a Failed Synchronization” on page 125

Overview

The initial directory synchronization process does the following:

• Exports all entries in the Exchange LDAP container specified in the synchronization ID 
file

• Adds all entries to the Scalix Server directory

• Converts Distribution Lists into Public Distribution Lists in Scalix Server

• Imports all entries from Scalix Server 

• Adds all entries to the specified Exchange container

Synchronizing the Directories

To synchronize the directories for the first time:

1 Log into Scalix Server.
123



Scalix Migration Guide | Task 6: Completing the Initial Directory Synchronization
2 To execute omldapsync in “interactive” mode, enter this command: 

omldapsync -i syncid

• Replace syncid with the name of your Exchange-Scalix migration synchroniza-
tion agreement. 

3 When the omldapsync menu appears, enter the number 2.

This prompts omldapsync to synchronize the directory for the first time. A series of 
status messages scrolls on-screen.

4 When the “export sa1 completed” confirmation message appears, the synchroni-
zation is complete, and was successful.

• If any error messages appear, follow the procedure in the next section to 
resolve the situation.

Managing Errors

It is not uncommon to encounter minor errors during the directory synchronization process. 
The omldapsync command notifies you of errors that occur during the synchronization of 
directories and provides an option to manage errors so that synchronization continues unin-
terrupted.

The following procedure describes a scenario in which the Exchange Distribution List repre-
senting the Scalix Server users was added and an error occurs when Scalix Server attempts 
to export the Distribution List.

1 Execute omldapsync in “interactive” mode by entering the following command: 

omldapsync -i syncid

2 When the omldapsycn menu appears, enter 3.

The following information displays:

STATUS: LDAP dir sync import sync01 started ###############

...

INFO: ... 0 entries to delete

INFO: ... 2 entries to add

INFO: ... 1 entries to modify

STATUS: delete old entries from flipper.bamail.net ...

INFO: ... 0 entries deleted

STATUS: add new entries to doclab.bamail.net ...

adding new entry cn=Scalix UsersDL,o=Scalix

ldap_add: Already exists

adding new entry cn=sName,o=Scalix

The ldap_add process notifies you that an entry already exists (this is where the 
Distribution List originated). 
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3 If you intentionally added the Exchange Distribution List knowing that omldapsync 
generates errors in this situation, you can “accept” the error by entering the fol-
lowing at the omldapsync prompt:

omldapsync -i syncid

4 When the omldapsync menu appears, enter 4 to accept the error and update the 
directory. 

The directory synchronization should now be complete.

Important Note

Note that omldapsync does not report errors. Subsequent updates will not attempt to add 
any missing entries. However, there are instances that require you to perform more labor-
intensive tasks such as manually modifying a directory entry on the Exchange or Scalix 
Server. 

Scalix Corporation recommends that you change the target side of the directory synchroni-
zation to resolve conflicts. For example, if you are trying to synchronize a new Exchange 
user named “John Doe”, and the remote recipient with the same name already exists in 
Scalix Server, change the remote recipient entry to “John Doe1” (or something similar) and 
select option 3 (Update the directory after some changes) in the omldapsync menu. omlda-
psync should report no errors. If errors do occur after you successfully add the “John Doe1” 
entry in the Scalix Server directory, select option 4 (Accept previous error and update direc-
tory) in the omldapsync menu to ignore the error. 

Resetting after a Failed Synchronization

There are multiple scenarios in which you would want to reset the Scalix after an initial 
omldapsync from Exchange is completed. 

1 Create a file with the name of all of the mailboxes that were to have been synchro-
nized in the first attempt. To do so, run this command:

omshowu –m all > allmailboxes.out

2 Use your preferred editor and open the file allmailboxes.out.

3 Delete the lines that contain the two system accounts: sxadmin and sxqueryadmin. 
These mailboxes should not be deleted along with the others.

4 Purge the other mailboxes by running this command:

omdelu –f allmailboxes.out

5 To create a new list of directory entries that you want to migrate to mailboxes, run 
this command:

omsearch –e “cn=*” –m cn > alldir.out

6 Use your editor to open this newly created file and remove the following entries: 

sxadmin, sxqueryadmin, ScalixAdmins, ScalixUserAdmins, ScalixGrou-

pAdmins, ScalixUserAttribtesAdmins. 
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These mailboxes either already exist (sxadmin and sxqueryadmin) or are mailboxes 
representing groups.

7 Run the original ommigu command with this new imput file, as shown here: 

ommigu –userfile alldir.out –m mailnode –p password –expire > 

ommigu.stdout 2> ommigu.stderr

8 Run the ommigu command, including the –raf option:

ommigu –userfile alldir.out –raf

The synchronization should now run without errors. 

Alert Don’t run the command in step 8 if the command run in step 7 results in errors.
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Task 7: Updating Exchange and
Scalix Directories

In the course of a phased migration, during which your Exchange directory (and mailboxes) 
may be modified daily, you should regularly update the Exchange and Scalix Server directo-
ries. This chapter explains how.

Contents
This chapter includes the following information:

• “Updating Exchange and Scalix Directories” on page 127

Updating Exchange and Scalix Directories

To update: 

1 Log in to the Scalix server.

2 Run omldapsync in “interactive” mode by entering the following command: 

omldapsync -i sync_id

• Replace syncid with a name for your Exchange-Scalix migration synchronization 
agreement. 

3 Enter 3 to update the directories.

This command synchronizes the directories on the Scalix Server and Exchange serv-
ers by comparing the current export file (which is created by selecting this option) 
with the previous export file. The omldapsync command adds, deletes, and modi-
fies entries in the appropriate directory

4 The results scroll on-screen, and when this update is complete, you will be 
prompted to exit.

Tip You can automate this directory update process by creating a script file that executes omlda-
psync with the appropriate command line switches—which are detailed in the man pages. 
You can schedule regular execution of the script as a cron job.



Task 8: Updating the Client Directory
Access

Scalix Server provides a client interface to the directory that acts as an index of all users. 
You can use this index to specify the directory entries that clients (such as MS Outlook, 
Internet clients, and LDAP clients) can access. When you modify the directory through any 
interface (including omldapsync), you must update client directory access before clients can 
view any new entries in the directory. This chapter explains how.

Contents
This chapter includes the following information:

• “Updating the Client Directory Access Index” on page 128

Updating the Client Directory Access Index

You must update the client directory access index after you successfully synchronize the 
Scalix Serer and Exchange directories.

To update the client directory access index:

1 Log in to Scalix Server.

2 Enter the following command:

omexeccda

The results scroll on-screen as illustrated here: 

Fetching all entries from Directory

Sorting Directory entries

Building Directory Access Tables... Please wait

... Please wait

... Please wait

When this is finished, the directory index will be updated. 
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3 You are prompted to exit.

Tip You can automate this process by including this script in a cron job.
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Task 9: Hiding Directory Entries in
Scalix Server

During the coexistence period, you may need to hide unwanted entries in the Scalix Server 
Directory, and at the same time, hide them from the Outlook Client Address Book. This 
requires the modification of a parameter in the Scalix Server Directory, which is described 
in this chapter.

Contents
This chapter includes the following information:

• “Hiding Directory Entries in Scalix” on page 130

Hiding Directory Entries in Scalix

In the following example, the Exchange entry for Scheduling and Freebusy lookup exports to 
Scalix Server are named “Microsoft Schedule+ Free\/Busy Connector (BAMEX55)”. 

To hide selected directory entries:

1 Enter the following command:

omsearch -e common-name=adm*

The following information appears on-screen:

COMMON-NAME=AdminSch=Microsoft Schedule+ Free\/Busy Connector 

(BAMEX55)/OU1=exchange/S=(BAMEX55)/OU2=bamail/ALIAS=AdminSch/

INTERNET-ADDR=AdminSch@bamail.net/G=Microsoft/LDAP-OBJECT-

CLASS=Mailbox-Agent=organizationalPerson=person=Top=ldapsync-

first/I=S COMMON-NAME=Administrator/OU1=exchange/S=Administrator/

OU2=bamail/ALIAS=Administrator/INTERNET-ADDR=Administrator@bam-

ail.net/LDAP-OBJECT-CLASS=organizationalPerson=person=Top=lda-

psync-first

2 To hide the COMMON-NAME=AdminSch=Microsoft Schedule+ Free\/Busy Connector 
(BAMEX55) directory entry, enter:

ommodent -e common-name=adminsch -n EX-CDA-DIRECTORY=1

The following information appears:
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Modified 1 entry in the Directory

3 To update the CDA, enter:

omexeccda
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Task 10: Preparing for Public Folder
Migration

This chapter explains how to prepare for public folder migration.

Contents
This chapter includes the following information:

• “Overview” on page 132

• “Determining Which Public Folders to Migrate” on page 133

• “Resetting Permissions on Public Folders” on page 133

• “Reorganizing Public Folders and Data” on page 133

• “Creating Public Folders on Scalix Server” on page 135

• “Checking Your Work” on page 135

Overview

Public Folder coexistence depends on the auto-forwarding of messages between Exchange 
and Scalix Public Folders. Only new messages are forwarded to Scalix Server after you 
enable auto-forwarding. 

Because enabling auto-forwarding before migrating data causes duplicate messages to dis-
play in the Scalix Server Public Folder, you must migrate Exchange Public Folder data to 
Scalix Server before enabling auto-forwarding.

Scalix recommends creating a backup folder for your Public Folders before you begin the 
migration and coexistence process.

During the Public Folder data migration process, you can migrate all data and maintain the 
current folder structure, or migrate some data and use the public folder data migration pro-
cess as an opportunity to delete old data and unwanted folders.

The Import/Export Wizard in the Outlook client manages the migration of public folder 
data. Before you begin migrating public folder data, you must:

• Determine the Public Folders you want to migrate.

• Reset the permissions on the Public Folders you want to migrate.
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• Reorganize the Public Folders you want to migrate.

• Prepare the Public Folders you want to migrate.

Each of these topics is covered separately in the rest of this chapter.

Determining Which Public Folders to Migrate 

When determining the public folders to migrate to Scalix Server, remember that any 
Exchange user can potentially create and manage access to a Public Folder. Some Public 
Folders might be very restricted and even administrators might not be able to access or 
manage these Public Folders. Alternatively, some organizations might have strict Public 
Folder policies where only administrators can create and manage Public Folders.

Scalix Corporation recommends that you notify all Exchange users before you migrate Public 
Folders so that Public Folder owners can consider whether to include their folders in the 
migration. 

You should also notify users that a new Public Folder owner will be established during migra-
tion and that all data messages will be visible to an administrator. 

Resetting Permissions on Public Folders 

After you identify the Public Folders you want to migrate, you must assign a new owner to 
each Public Folder so that you can create:

• The exported .pst file which you import into Scalix Server

• A new rule using the Folder Assistant that enables cross-platform synchronization

For example, your organization may want to designate one of your administrative-access 
accounts (that is part of an Administration group) to be the “owner” of most of the Public 
Folders within the organization. You need to make sure that this admin account is an owner 
of all Public Folders that you eventually choose to migrate.

Reorganizing Public Folders and Data

When you determine the Public Folders that you want to migrate to Scalix and configure the 
Public Folder owner permissions for those folders, Scalix Corporation recommends that you 
create a “clean and migrate” directory where you can reorganize public folders and data.

To create a directory for reorganizing public folders and data: 

1 Using a Microsoft Exchange profile, log into the Outlook Client as the designated 
administrative-access Public Folders owner. 

Notes: Any folder that is restricted in Exchange (a default Role set to the value of None) is set to a 
default Role of Publishing Author after it is imported into Scalix Server. To prevent restricted 
users from viewing the contents of a Public Folder, change the default role to None after you cre-
ate the Public Folder using the .PST import. 

Tip Write down the user name of this “folder owner” administrator account.
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2 Click the All Public Folders folder (inside Public Folders).

3 Choose File > Folder > New Folder.

The Create New Folder dialog box appears. 

4 Enter “Clean and migrate” in the Name field.

• Note that the target folder is shown in the explorer view in this dialog box.

5 Click OK.

6 When the Outlook window reappears, right-click the “Clean and migrate” folder 
icon and choose Properties from the popup menu.

The Properties dialog box appears. 

7 Make sure the following settings are in effect:

• Initial View -- Should be “Normal”
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• Drag/Drop posting -- Should be “Move/Copy”.

• This folder is available to -- Should be “All users with access permission”

8 Click OK to save your settings and close this dialog box.

9 Right-click all of the to-be-migrated public folders and drag them onto the “Clean 
and migrate” folder.

10 When the popup menu appears, click Copy.

The contents of all public folders are copied into this migratable folder. 

Creating Public Folders on Scalix Server

After you determine the Public Folders to migrate from Exchange, you should first create a 
matching set of Public Folders on the Scalix Server. The name of each Public Folder must be 
exactly the same as the name of the source Public Folder on Exchange server. 

For example, if you want to migrate the Exchange Public Folder “For Sale” to Scalix, enter 
this command:

omaddbb -s “For Sale”

Repeat this command to create all the other source public folders.

Checking Your Work

To verify the success of your work:

1 Start Outlook, using the Scalix profile.

2 Open the Public Folders list.

3 Verify that the folders that should have been migrated from “Clean and migrate” 
are listed here.

Tip The migration process provides you an excellent opportunity to delete legacy data from your Pub-
lic Folders. The data that you decide to exclude (if any) from the migration process depends on 
the migration policies implemented by your organization. To remove unwanted messages, open 
the Public Folders and delete the messages that you do not want to migrate to Scalix Server.
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Task 11: Migrating Public Folder Data
to Scalix Server

This chapter explains the method for doing the actual migration of public folder data to 
Scalix.

Contents
This chapter includes the following information:

• “Requirements:” on page 136

• “Exporting Exchange Public Folder Data” on page 136

• “Importing the Exported Public Folders into Scalix” on page 139

Requirements:

If you have not already done so, create the two e-mail user profiles in the Windows Mail con-
trol panel that Outlook will refer to in this process:

• Scalix

• Exchange

Exporting Exchange Public Folder Data

To migrate the contents of a specific Public Folder to Scalix Server.

1 Using a Microsoft Exchange profile, start the Outlook Client.

This allows you to connect to the Exchange server as a Public Folder owner.

2 Choose File > Import/Export. 
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The Import/Export Window (for export) appears. 

3  Select “Export to a File”, and click Next.

The Export To a File wizard panel appears. 

4  Select Personal Folder File (.pst), and click Next.

The Export Personal Folders (Selection) wizard panel appears. 
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5 Navigate to the folder into which you copied the Exchange Public Folders that you 
want to migrate (“Clean and migrate”).

6 Make sure you check the Include Subfolders check box.

7 Click Next. The Export Personal Folders (Save As) wizard panel appears. 

8  Enter a name for the file (in the format “file_name.pst”) and specify a folder loca-
tion in which to save the file. 

9 Click Finish.

A dialog box appears 

10 If you have concerns about the vulnerability of your public folder data, enter a 
password for the .pst file.

11 Click OK to proceed.

12 A series of export status dialog boxes appears, representing the contents of each 
folder.

When the status dialog boxes cease, you can now import the .pst file to the Scalix 
Server. 

Note Write down the filename and location pathway for future reference (in the context of migra-
tion).
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Importing the Exported Public Folders into Scalix

To import the just-exported .PST files into Scalix:

1 Using a “Scalix” profile, start Outlook.

This allows you to log in as a Public folder owner on the Scalix server.

2 Select “Public Folders” in the Folder List.

3 Choose File > Import/Export. 

The Import and Export wizard appears. 

4 Select “Import from Another Program or File”, and click Next. 

The Import a File wizard panel appears. 

5  Select “Personal Folder File (.pst)”, and click Next. 
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The Import Personal Folders wizard panel appears. 

6 Click Browse, and use the browse dialog box to locate and select the .PST file 
that you exported previously. 

7 Click the check box by “Replace Duplicates with Items Imported”.

8 Click Next. 

The Import Personal Folders wizard panel appears. 

9 Use the explorer view to locate and select the top-level folder (“clean and 
migrate”) that contains the Public Folder(s) you want to migrate.

10 Click the check box by Include Subfolders to enter a check mark.

11 Click the button by “Import Items into the Current Folder”.

12 Choose “Mailbox - username” from the pull-down menu. 

13 Click Finish.
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Task 12: Enabling Public Folder For-
warding on Scalix Server

This chapter explains how to enable public folder forwarding in Scalix.

Contents
This chapter includes the following information:

• “Overview” on page 141

• “Examples” on page 141

• “Arguments for the Command” on page 142

• “Activating Forwarding” on page 143

• “Testing Your Work” on page 143

Overview

The Public Folder coexistence process requires you to (1) enable forwarding capabilities on 
the Scalix Server Public Folder, then (2) to create an Internet-routable e-mail address to be 
applied to public folders on Scalix. This address could take the format:

[publicfoldername]@scalixserver.companyname.com

Enabling forwarding allows a copy of a message posted to a given Public Folder in Scalix 
Server to automatically be forwarded to a similarly-named Public Folder on Exchange. 

You must use the following two commands to enable Public Folder forwarding on Scalix 
Server:

• omaddent 

• omaddbbsa

Examples

The specific use of omaddent results in a directory entry associated with the Public Folder 
and creates an SMTP address to receive inbound mail. It can be used three ways:

Example 1: Create a directory entry with accompanying e-mail address
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We want to create a new Scalix Server Public Folder named For Sale (to be used by Acme 
Corporation mail users. The Internet domain is acme.net, on a mailnode named scalix-
server. To do so, we create a directory entry as shown here (each item on a single line):

omaddent –e “S=+BB/G=For Sale /CN=For Sale/ OU1=scalixserver/

OU2=acme/DDT1=BB-NAME/DDV1=For Sale/

IA=ForSale@scalixserver.acme.net” 

Example 2: Hide the new entry (and e-mail address) immediately after creation

To create and then hide the directory entry for the “For Sale” Public Folder on Scalix, we 
enter the following:

omaddent –e “S=+BB/G=For Sale /CN=For Sale/ OU1=scalixserver/

OU2=acme/DDT1=BB-NAME/DDV1=For Sale/

IA=ForSale@scalixserver.acme.net/ EX-CDA-DIRECTORY=1” 

Example 3: Retroactively hide the previously created (visible) entry

If we previously created the “For Sale” Public Folder entry and want to hide the entry at a 
later time, we enter the following:

ommodent -e S=+BB/G=For Sale/CN=For Sale/OU1=scalixserver/OU2=acme 

-n EX-CDA-DIRECTORY=1

Arguments for the Command

The arguments of this command must include the following:

S This argument must be set to +BB.

G This argument specifies the user-visible name of the Public Folder.

CN This argument specifies the Common Name which is required by the 
omldapsync command.

OU This argument specifies the mailnode components, and you must enter 
the primary mailnode to route messages to the Public Folder server. Use 
the omshowmn command to display the primary mailnode. The primary 
mailnode displays with two asterisks (**) before the mailnode name.

DDT1 This is an internal tag that must be set to BB-NAME. Leaving the DDT1 
blank causes Scalix Server to route Public Folder messages to a Unix 
gateway.

DDV1 This is an internal tag and must be set to the name of the Public Folder 
you are enabling. If the public folder name contains non-ASCII charac-
ters such as Japanese characters or German unlauts, DDV1-TX must be 
used instead of just DDV1.

Note If the public folder name contains non-ASCII characters such as Japanese characters or 
German umlauts, DDV1-TX must be used instead of just DDV1.

Note If the public folder name contains non-ASCII characters such as Japanese characters or 
German umlauts, DDV1-TX must be used instead of just DDV1.
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INTERNET-ADDR This is the SMTP address that is used outside the Scalix Server system to 
send messages to the Public Folder.

• Make sure you update the CDA after adding or modifying entries in Scalix (using omex-
eccda) as described previously in “Task 8: Updating the Client Directory Access” on 
page 128.

Activating Forwarding

After you create a directory entry associated with the Public Folder, you must activate a 
forwarding option in the similarly-named Exchange Public Folder. This is done by providing a 
“forward to external address” option in the Scalix Server Public Folder Synchronization 
mechanism. 

The omaddbbsa command allows you configure a forwarding address that forwards any new 
messages to the specified Public Folder to an address that you specify as follows:

omaddbbsa –f /route/forwarding_address/ -s public_folder_name

For example, to configure forwarding from the Scalix Server “For Sale” Public Folder to the 
external SMTP address "ForSale@bamex55.bamail.net", enter the following:

omaddbbsa –f /remote,tnef/IA=ForSale@bamex55.bamail.net –s “For 

Sale”

The remote,tnef parameter is the mailnode route that references the Exchange server. This 
ensures that the forwarded messages preserve all MAPI properties.

Testing Your Work

To verify that the public folder forwarding mechanism is functioning, post a message to a 
public folder in Scalix, then check the corresponding folder in Exchange to see if that mes-
sage was successfully forwarded.

Note This option provides functionality equivalent to the Exchange Public Folder forwarding rule, 
that is, only new Public Folder messages are synchronized between the Scalix Server and 
Exchange server. Modified and deleted messages are not synchronized.
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Task 13: Enabling Public Folder For-
warding Capabilities on Exchange

The final task in the Public Folder coexistence process requires you to enable forwarding 
capabilities on the Exchange server. This chapter explains how.

Contents
This chapter includes the following information:

• “Overview” on page 144

• “Requirements” on page 144

• “Activating Folder Forwarding” on page 145

Overview

To complete bidirectional bulletin board message routing, you must configure Exchange 
Public Folders to forward a copy of a newly posted message to similarly-named Scalix Server 
Public Folders. The Exchange server has custom recipients that have an SMTP address that 
reference similarly-named Scalix Server Public Folders. For example, the “For Sale” Public 
Folder, which now has a similarly-named Public Folder on Scalix Server, now has a custom 
recipient.

The Internet address for “For Sale”, like other custom recipients, references an external 
SMTP address (for example, ForSale@scalixserver.acme.net). You must then add a forward-
ing rule that enables the Exchange server to forward a copy of a “For Sale” Public Folder 
message to the “For Sale” custom recipient. Exchange then routes the message to the Scalix 
Server Public Folder (named For Sale). 

Requirements

To prevent message loops, you must configure Exchange to only forward messages (to Scalix 
Server) posted by Exchange mailbox users. The most efficient method of archiving this is by 
using Distribution Lists.

ALERT Notes in Public Folders cannot be forwarded to Scalix.
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Most organizations have a method of broadcasting a messages to some or all members of an 
organization by using one or more Distribution Lists. However, you can also use Distribution 
Lists for Public Folder forward functionality.

Activating Folder Forwarding

To enable Exchange to forward messages from Exchange public folders to correspond-
ing folders on Scalix:

1 Start Outlook as the “owner” of an Exchange-based Public Folder.

2 Right-click the Public Folder you want to set up and choose Properties in the 
popup menu.

3 When the [Foldername] Properties dialog box appears, click the Administration 
tab. 

4 Click Folder Assistant.

The Folder Assistant dialog box appears. 

5  Click Add Rule.
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The Edit Rule dialog box appears. 

6  Click From.

The Choose Sender dialog box appears. 

7 Make sure “Global Address List” is the Show Names From option

8 Select an Exchange distribution lists (represented by two-headed icons) whose 
users you want to allow to post to Public Folders.

9 Click From to move that list to the right list area.

10 Repeat this process to add other lists to the From list area.

The selected names should all appear in the right-hand field in a “text-only” run-on 
list.

11 Click OK to save the selections and close the Choose Sender dialog box. 
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The Edit Rule dialog box reappears, displaying the selected groups. 

12 Click the Forward check box to enter a check mark.

13 Select “Leave Message Intact” from the Method pulldown menu.

14 In the To button text field (above the Method menu), enter the Internet address 
of the similarly named Public Folder stored on Scalix.

15  Click OK to close this dialog box and save the entries.

16 Click OK to close all other currently open dialog boxes.

17 To test the success of your efforts, post a new message to an Exchange Public 
Folder, then see if it’s visible in the corresponding Scalix Public Folder.
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Task 14: Effective Distribution List
Coexistence

This chapter covers several tips for effective coexistence of public distribution lists (PDLs or 
Groups).

Contents
This chapter includes the following information:

• “Overview” on page 148

• “Creating the PDL and Custom Recipient” on page 148

Overview

There is no central mechanism that synchronizes Distribution Lists. Instead, Distribution 
Lists are managed by either the Scalix Server or Exchange system. Whichever system is not 
the manager must include a reference entry that sends a single message to the host system 
where the Distribution List resides. The Distribution List is then updated. 

Although the Exchange or Scalix Server system can manage Distribution Lists, Scalix Corpo-
ration recommends that you manage Distribution Lists in Exchange until the end of the coex-
istence process.

As previously noted in “Task 2: Preparing the Exchange Users Distribution List” on page 109, 
Scalix Server creates directory entries that represent Exchange Distribution Lists and dis-
plays them as PDLs. To achieve this in Exchange, you must create a Distribution List and add 
the Scalix Server custom recipient of the same name.

Creating the PDL and Custom Recipient

To create a PDL and add the Scalix custom recipient:

1 Start the MS Exchange Administrator application.

2 Select the container from which you migrated Exchange users (for example, Recip-
ients).

3 Choose File > New Distribution List.
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A Properties dialog box appears. 

4 Click Modify (in the Members area).

5 Add all Scalix users to the Distribution List. 

6 Enter a name in the Display Name field.

7 Enter a name in the Alias Name field. (It doesn’t have to be different.)

8 Click OK to save your entries and close the Properties dialog box.

Updating Directory Information
9 Log in to Scalix.

10 Enter the following omldapsync directory-update command at the prompt:

omldapsync -i syncid

• Replace “syncid” with your existing synchronization agreement name.

11 When the omldapsync menu appears, enter 3 to update the directory.

The results scroll on-screen, then, at the conclusion, you are prompted to exit 
omldapsync.

Updating Client Directory Access List
12 Log in to Scalix (if you have not already done so).

13 Enter this command at the prompt:

omexeccda

ALERT Do not add ScalixAdmins, ScalixGroupAdmins, ScalixUserAdmins, ScalixUserAttributeAd-
mins, or querymgr to the new Scalix Distribution List.
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That completes this task.

Note
You cannot view Exchange PDL members in Scalix (using either Scalix Connect for MS Out-
look or Scalix Web Access), however you can see the PDL name. Be sure to exist and then re-
start Outlook, if you were logged into Scalix during the recent operations. This allows it to 
refresh its displays.
150



Task 15: Planning the Exchange to
Scalix Migration

If you have completed all the coexistence and pre-migration setup tasks (detailed in the 
previous chapters), you can now begin the process of migrating all Exchange users to the 
Scalix Server environment. But first, some planning guidelines, as migration of legacy data 
(users and data) will involve many tasks (and potentially a number of co-workers.) This 
chapter outlines some of those guidelines.

Contents
This chapter includes the following information:

• “Planning Guidelines” on page 151

Planning Guidelines

Scalix Corporation recommends that you create a planning document that includes how you 
will group migrated users. Migration considerations include (but are not limited to):

• Geographic location

• Workgroup

• Server consolidation efforts

• Network bandwidth availability

• Scheduling (including down times for the legacy system)

• Number of users and subgroups of migratable users

• Migration intervals (e.g., which weekends to book in advance)

• Number of available migration workstations to employ in data migration

The migration information described in the following chapters describe how to migrate 
either a single user, one at a time, or multiple users, all at the same time. Migrating multi-
ple users concurrently involves creating input files for scripts, writing or customizing scripts 
in Scalix Server, while using Microsoft utilities to manipulate data within Exchange.

The actual migration process involves the following procedures:

•  “Loading Scalix Server Mailboxes” on page 45
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•  “Configuring Forwarding in Exchange” on page 50

•  “Migrating Mailboxes” on page 56

•  “Decommission the Exchange Mailbox” on page 71
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Task 16: Provisioning Scalix Server
Mailboxes

This chapter explains how to provision Scalix mailboxes using the ommigu command.

Contents
This chapter includes the following information:

• “Overview” on page 153

• “Provisioning a Single Test Mailbox” on page 154

• “Verifying the New Mailbox” on page 154

Overview 

The actual Scalix Server migration process (outside of coexistence) initially requires that 
you convert Exchange directory entries to Scalix Server mailboxes. The principal tool is a 
Scalix-originated command, ommigu. This command specifically modifies Scalix Server 
directory entries that represent Exchange users. After omldapsync loads a Scalix Server 
directory with Exchange directory objects (such as mailboxes, custom recipients, distribu-
tion lists), the next step is to modify the objects so that they become mailboxes, ready for 
use or for data importation.

You must apply ommigu to all Scalix directory objects that will become local Scalix mail-
boxes. For example, if an organization has 10,000 Exchange mailboxes planned for migration 
onto two Scalix Servers (5000 users on each), you can now provision all 5000 users at this 
stage of the migration process. The unprovisioned 5000 users remain on the other Scalix 
server as directory entries that (respectively) reference (using a SMTP address) the original 
Exchange mailbox (similar to the period after the initial synchronization occurred using 
omldapsync).

ommigu converts each directory object to a full Scalix Server mailbox while excluding it 
from the omldapsync process. ommigu also creates auto-forwarding information in the mail-
box so that mail addressed to a Scalix Server mailbox routes back to the respective 
Exchange mailbox (using an SMTP address). 
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Provisioning a Single Test Mailbox

To provision a single directory entry as a mailbox (to validate the process):

1 Log in to Scalix.

2 Open a terminal window and enter the following:

ommigu -n “Exchange Display Name” -m “Scalix mailnode of the user” 

-G 

The command arguments include the following:

• “Exchange Display Name” is the equivalent of the Scalix Server Common Name 
attribute.

• –G  generates a random password for the mailbox. 

• –p <password> lets you specify a specific password. 

• -expire force users to specify a new account password the first time they log in 
to Scalix Server. 

Here are some example mailbox-provisioning commands

ommigu –n “Forest Stevens” –m “xyzcorp,usa” –G

ommigu –n “Dave Johnson” –m “xyzcorp.usa –p 123456 –e

3 Use these two commands to assess the results in Scalix:

omsearch -e cn=*

(This will list the new mailbox by Common Name.)

omshowiam -m -ca=”exchange_display_name”

(This will list the attributes for the user.) 

Verifying the New Mailbox

To see if the new mailbox appears in Outlook:

1 Start Outlook, using a Scalix profile.

2 Set up an account for the new mailbox.

3 Log into that mailbox.

4 Choose Tools > Send/Receive. This will verify a connection to the server.

Note The mailbox should note the status of ‘unlocked”.
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Task 17: Bulk Mailbox Provisioning
and Configuration

This chapter explains how to provision Scalix mailboxes in bulk, using the ommigu command.

Contents
This chapter includes the following information:

• “Overview” on page 155

• “Using Exchange Attributes to Provision Scalix Mailboxes” on page 155

• “Using Scalix Server Attributes” on page 156

• “Using the Userfile Option” on page 157

Overview

The ommigu script contains powerful filtering capabilities that you can use to organize users 
into migration groups. This enables you to migrate the users in your organization in phases. 
A phased migration implies that there will be (for select users) an extended coexistence 
period between Exchange and Scalix Server. 

Performing the tasks described in “Loading Scalix Server Mailboxes” provisions and config-
ures a mailbox for use with Scalix Server. ommigu filtering capabilities enable you to provi-
sion and configure groups of users based on:

• Attributes in the Exchange directory 

• Attributes in the Scalix Server directory

• A userlist text file

Each of these options are detailed separately in the rest of this chapter.

Using Exchange Attributes to Provision Scalix Mail-
boxes

To use Exchange attributes to provision a group of users (mailboxes):

1 Use the –ldapfilter option as follows:
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ommigu –ldapfilter “attribute=string” –h ldapserver

2 In this command line, the following are true: 

• attribute represents the LDAP representation of the Exchange attribute

• string represents the string within the Exchange attribute

• ldapserver represents the server against which you are executing the query 
(typically, the Exchange server itself). 

For example:

ommigu –ldapfilter “l=Boston” –h ex55ord.xyzcorp.com –m “xyz-

corp,hq”

Because the city attribute in Exchange contains the LDAP representation of l, 
ommigu queries the Exchange server for all users that contain the string Boston in 
the city field. 

All users matching this criteria are provisioned for use with Scalix Server. 

3 Configure these users for use with Scalix Server by entering:

ommigu –ldapfilter “attribute=string” –h ldapserver -–raf

4 Execute omldapsync in “interactive” mode. Enter, 

omldapsync -i syncid

5 Enter 3 to update the directory. 

6 The results scroll on-screen, and when this task is complete, you will be prompted 
to exit.

Using Scalix Server Attributes

When the initial synchronization between Scalix Server and Exchange (using omldapsync) 
occurs, most of the information stored in Exchange directory attributes is mapped to corre-
sponding attributes in the Scalix Server directory. Therefore, you can provision the Scalix 
Server system directory using either the –ldapfilter or –filter option. 

Using the –ldapfilter option requires that you include the LDAP representation of the Scalix 
Server attribute. Using the –filter option requires you include the Scalix Server name of the 
attribute (typically referred to as a tag). For example:

1 Provision all users (mailboxes) in the Scalix Server directory with the Given Name of 
Mark by entering:

ommigu –filter “G=Mark” –show 

2 Because the LDAP representation of this field is givenName, you can also provision 
the Exchange server for all directory objects with a given name of Mark.

3 To do so, enter the following command:

ommigu –ldapfilter “givenName=Mark” –h ldapserver –show

4 Configure these users for use with Scalix Server by entering:

Note The name of the Scalix Server is not required.
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ommigu –ldapfilter “givenName=Mark” –h ldapserver -–raf

5 Execute omldapsync in “interactive” mode. Enter, 

omldapsync -i syncid

6 See “omldapsync Interactive Menu Options” on page 12 for information about the 
menu options for the omldapsync command.

7 Enter 3 to update the directory. The following information displays:

8 Enter 3 to update the directory. 

9 The results scroll on-screen, and when this task is complete, you will be prompted 
to exit.

Using the Userfile Option

You bulk provision and configure users using the ommigu -userfile option. The userfile itself 
(from which the name of the option is derived) is a text file that lists the Scalix Server com-
mon name attribute for all users. Because the Scalix Server common name corresponds to 
the Exchange display name attribute, you can use the directory export capabilities in the 
Exchange Administration application to extract users to a comma-separated file. 

To provision and configure a group of users (mailboxes) using the -userfile option:

1 Using the Exchange Administration application, extract the current users to a 
comma-separated file. 

2 Edit the file to remove the users you do not want to migrate. 

3 Save the file in .txt format, using the “.txt” extension.

4 Provision the mailboxes in this list by entering this command:

ommigu –userfile <path>/grp1.txt

5 Configure these users for use with Scalix Server by entering:

ommigu –userfile <path>/grp1.txt -–raf

6 To run omldapsync in “interactive” mode, enter the following: 

omldapsync -i syncid

• Replace syncid with the actual agreement name.

7 At the next prompt, enter 3 to update the directory. 

The results scroll on-screen, and you are prompted to exit.

If You are Asked for Passwords
1 If this prompt appears after you’ve entered “3”:

INPUT: please enter password for EX_PASS=

Enter the Exchange migration user password. 

2 When this prompt appears:

INPUT: please enter password for IM_PASS=
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Enter the Scalix Server administrator password.

The results scroll on-screen, and when this task is complete, you will be prompted 
to exit.
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Task 18: Reconfiguring Auto-Forward-
ing for the New Scalix Mailboxes

This chapter provides steps for removing the auto-forwarding on Scalix mailboxes so that 
mail goes directly to Scalix.

Contents
This chapter includes the following information:

• “Disabling Auto Forwarding” on page 159

Disabling Auto Forwarding

After you provision the new Scalix mailboxes from the directory entries, you must do the 
following:

• Remove the forwarding (SMTP) address on Scalix Server mailboxes

• Allow omldapsync to update the Exchange directory

Both tasks can be accomplished with the CLI command, ommigu, as detailed here.

To reconfigure auto-forwarding:

1 Log in to Scalix.

2 Open a terminal window and enter the following:

ommigu -n “Exchange display name” --raf

This command removes the auto-forwarding to Exchange mailboxes

It also updates other mailbox settings to indicate that the mailbox is associated to a 
migrated user and is ready for use.

3 To run omldapsync in “interactive” mode, enter the following:

omldapsync -i syncid

• Replace syncid with the actual agreement name.

4 At the prompt, enter 3 to update the directory.

5 The results scroll on-screen, and when this task is complete, you will be prompted 
to exit.



Task 19: Configuring Message For-
warding from  Exchange to Scalix

At this point, you must configure Exchange to route all new mail messages to Scalix Server 
mailboxes. This enables you to migrate data from what are now legacy Exchange mailboxes 
without having new mail or other data reaccumulate in just-migrated Exchange mailboxes. 
This chapter explains how to configure the routes. 

Contents
This chapter includes the following information:

• “Overview” on page 160

• “Adding Alternate Recipient Information for a Single Mailbox” on page 161

• “Adding Alternate Recipient Information for Several Mailboxes” on page 162

Overview

You must configure an Alternate Recipient address for every Exchange mailbox you plan to 
migrate. The Alternate Recipient address routes messages originally destined for the 
Exchange mailbox to a different address—the Scalix Server mailbox. This alternate address 
must exist in the Exchange GAL.

The omldapsync command has already added an Exchange custom recipient entry for each 
mailbox in the current migration group. This custom recipient entry contains an SMTP 
address that routes to the Scalix Server mailbox. You must now record these custom recipi-
ent entries in Exchange as the Alternate Recipients for each mailbox. 

There are two methods you can use to add alternate recipient information in Exchange:

• One entry at time

• Multiple entries at one time

Each of these methods are detailed in this chapter
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Adding Alternate Recipient Information for a Single 
Mailbox

To add Alternate Recipient information for a single Exchange mailbox:

1 Start the Microsoft Exchange Administration application.

2 Open the Recipients list (or whichever list you’ve created) for your Exchange 
site.

3 Locate the first mailbox associated with a user you are migrating to Scalix Server, 
and double-click the entry.

The [username] Properties dialog box appears.

4 Click the Delivery Options tab. 

5 Click Modify (in the middle of the dialog box.)

The Mailbox [username] dialog box appears.
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6 Make sure Global Address Files is selected in the upper-right menu.

7 Scroll through the left-hand column and find the directory entry with a Globe icon 
that has the same name as this user’s mailbox. 

8 Select this entry and click Add. 

The selected directory entry appears in the list column to the right.

9 Click OK to close the Mailbox dialog box.

10 When the Properties dialog box reappears, click OK to put the custom recipient 
entry into effect.

Adding Alternate Recipient Information for Several 
Mailboxes

Typically, the migration from Exchange to Scalix Server includes hundreds of users. There-
fore, adding alternate recipient information one mailbox at a time would be inefficient. 

Using the Exchange Import and Export tools in conjunction with modified output files, you 
can add hundreds of alternate recipients to existing Exchange mailboxes at the same time.

To add alternate recipient information for a large number of mailboxes: 

1 Open the Exchange Administration application.

2 Choose Tools > Directory Export.

The Directory Export dialog box appears. 

3 To create a directory export file of Exchange mailboxes, make these entries:

• The default Exchange server and Home server names are acceptable.

• The default settings/selections in Export Objects, Logging Level, and Separators 
are acceptable.

Note There should be a listing for this user’s mailbox—with no icon—as well as a second listing 
with a globe icon—representing the custom recipient that routes incoming mail to this user’s 
Scalix mailbox.
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• Do not check “Include Hidden Objects”.

• Click Export File.

• When a dialog box appears, name this file and pick a target folder. 

• Enter a name that identifies the contents of the output file, and make sure the 
“.csv” extension is present.

4 Click Export to start the process. 

Modifying the Output File
Typically, you are migrating users in groups that are a subset of the container you specify in 
Step 3 of “Adding Alternate Recipient Information for Several Mailboxes” on page 52. There-
fore, you must modify the output file so that it contains only the mailboxes to which you 
want to add alternate recipient information. 

To modify the output file:

1 Start Microsoft Excel.

2 Choose File > Open, and open the output file from your directory export. 

3 Choose File > Save As.

4 When the Save As dialog box appears, save this file with a different file name. 

5 Verify that the output file ends with column M, and that column N is empty.

6 In cell N1 (of column N), type “Alternate Recipient” as the column header. 

7 Save these changes.

Entering Custom_Recipient_Container and Alias_Name Parameters
Before you modify the exported-directory output file in Excel, be aware of the following 
information:

• The output file displays the following string in Column E: 

/o=Organization/ou=Site/cn=Custom_Recipient_Container/

cn=alias_name

• The MS Excel output file displays the following string in Column L (the Obj-Container 
header): 

/o=XYZ/ou=XYZNA/cn=America

Using the Exchange Administration application, you can determine that omldapsync stored 
the custom recipients in the America-CR container.

To complete the alternate recipient entry process for your Exchange mailboxes:

1 With your exported directory output file open in Excel, enter the following string at 
the bottom of the spreadsheet (in the first empty row below all existing entries): 

/o=XYZ/ou=XYZNA/cn=America-CR/cn=

Tip Write down the name and folder location of t his file.
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2 Enter a concatenation formula in cell N2 that adds the string from the static cell 
and the value in column E. For example, if you enter static data in cell A120, cell 
N2 must have the following formula:

=concatenate($A$120,E2)

3 Apply the same formula for all other entries in column N. Select (highlight) cell N2 
and press Ctrl + c to copy the contents. Highlight all the other entries in column N 
and press Ctrl + v to paste the contents. 

The text string that displays in the Alternate Recipient column contains four 
parameters (with delimiters).

/o=Organization/ou=Site/cn=Custom_Recipient_Container/

cn=alias_name

Here are the alternate recipient column parameters 

4 Verify the accuracy of the data, then choose File > Save As to save the file with a 
different name. Make sure you click Yes at the Retain the Format prompt. 

5 Choose Tools > Import > Select File to import the file into Exchange. 

You can use the default values for Account creation, Logging level, and Separators. 
The Container value is where the mailboxes (not the custom recipients) reside.

6 Use the Exchange Administration application to check the properties of a sampling 
of mailboxes—especially the Delivery Options tab where an Alternate Recipient 
should appear.

Parameter Description

Organization Displayed in column L.

Site Displayed in column L.

Custom_Recipient_
Container

The container into which omldapsync inserted the Custom Recipient infor-
mation. Use the Exchange Administration application to obtain the name of 
the container.

alias_name

The Alias Name displays in column E, and the text string you enter in column 
N depends on the alias_name value.The rest of the string is identical for 
each cell. You can enter static informaation in a single cell and use the Con-
catenate function in Excel to combine the data from column E in the same 
row. 
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Task 20: Decommissioning the
Exchange Mailboxes

This chapter explains how to decommission the old mailboxes so that they are hidden from 
use but not deleted.

Contents
This chapter includes the following information:

• “Overview” on page 165

• “Decommissioning Mailboxes One at a Time” on page 165

• “Decommissioning Multiple Mailboxes at a Time” on page 166

Overview

When you complete the migration of all the mailboxes (including mailbox data), you can 
decommission the Exchange mailboxes. This process makes them unusable without deleting 
them. Since a custom recipient of the same name already exists in the GAL, you can hide 
the Exchange mailboxes without adversely affecting the system. 

This task will result in the deactivation of all Exchange mailboxes, preventing them from 
being accessed by their users.

Decommissioning Mailboxes One at a Time

To decommission a single mailbox:

1 Start the Exchange Administration application.

2 Open the container (by default, “Recipients”) containing the migrated mailboxes.

3 Double-click any mailbox entry, to open the Properties dialog box.
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4 Click the Advanced tab. 

5 Click the checkbox by Hide from Address Book (as highlighted above).

6 Click OK to save the change and close the dialog box.

Decommissioning Multiple Mailboxes at a Time

To simultaneously decommission (hide) a number of Exchange mailboxes:

1 Open the backup file you created previously.

2 Verify that Column M contains a header named “Hide from AB” (address book) and 
has a value of “0” (zero). 

3 Change the value in column M to “1”.

4 Save the file.

You can now import the file into Exchange by following these steps:

1 Start Exchange Administration.

2 Choose Tools > Directory Import.
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3 The Directory Import dialog box appears. 

4 Choose from the following options.

• Click Import File and use the dialog box to locate and open the Excel file.

• Use the default values for Account Creation, Logging Level, and Separators. 

• The Container value indicates where the mailboxes (not the custom recipients) 
reside.

5 Click Import.

A status dialog box appears, and closes when this task is complete. 

Verifying Decommissioning
1 Start the Exchange Administration application—or the Outlook client.

2 Verify that the mailboxes are no longer visible in the Exchange GAL.
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Task 21: Post-Migration and Coexist-
ence Closure Tasks

The chapter outlines a series of tasks that will end coexistence between Scalix Server and 
Exchange, and complete the migration of Exchange users and data to Scalix Server.

Contents
This chapter includes the following information:

• “Managing Distribution Lists” on page 168

• “Scalix Server Distribution List Synchronization” on page 169

• “Managing Distribution Lists from Exchange” on page 169

• “Switching Distribution List Management to Scalix” on page 169

• “Switching PDL Management After Coexistence” on page 174

Managing Distribution Lists

As a phased migration proceeds, one serious question arises: how to coordinate Distribution 
Lists. Some recipients on a Distribution List still reside in the old environment (Exchange) 
while some recipients are migrated to the new environment (Scalix Server). 

If you delete Exchange mailboxes (after successful migration to Scalix Server), any alternate 
recipient information (referencing the new Scalix Server mailbox) will be removed from all 
Exchange Distribution Lists. If this poses a problem, you can manually insert the reference 
to the Scalix Server mailbox back into all Exchange Distribution Lists to which the just-
migrated users belong. 

However, during the migration process, Scalix Server provisions directory entries as mail-
boxes with automatic redirection instead of redirection-only entries. The benefit of provi-
sioning entries in this manner is that it enables the option of mirroring the structure and 
members of Public Distribution Lists on Scalix Server at anytime. As users are migrated from 
Exchange to Scalix Server, you do not have to delete and add the directory entry into the 
list. Similarly in the Exchange environment, the management of Distribution Lists during the 
migration to Scalix Server is simplified because you do not have to remove mailboxes. 

Although you eventually add (and hide) alternate recipient information to Exchange mail-
boxes, you do not need to remove mailboxes and replace them with custom recipients dur-
ing the migration process.
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Scalix Server Distribution List Synchronization

Exchange objects that are either custom recipients or mailboxes (that eventually reside on 
the Scalix Server) are classified as remote recipients by Scalix Server. All Exchange Distribu-
tion Lists become Scalix Server Public Distribution Lists (PDL’s) and all Distribution Lists are 
configured to automatically forward to the SMTP address of the respective Exchange Distri-
bution List.

Managing Distribution Lists from Exchange

After you execute omldapsync and ommigu, create a test account on Scalix Server to vali-
date Distribution List routing. A message addressed to the Scalix Server PDL from the test 
account should be delivered to the recipients on the PDL. The message should also deliver a 
copy of the message to the respective Exchange Distribution List, where it is then delivered 
to the respective recipients of the Exchange Distribution List. In this scenario, a single mes-
sage is routed from Scalix Server to Exchange, where it is then dispersed to the recipients, 
none of which reside in the Scalix Server environment at this point of the process.

Switching Distribution List Management to Scalix

You can switch Distribution List management from Exchange to Scalix either during the 
coexistence period or after coexistence. This requires the creation of an Exchange Custom 
Recipient entry with the Internet address of a specific Scalix Server Public Distribution List 
and a unique display name (for example, SALES-PDL).

To switch distribution list management to Scalix:

Creating a Custom Recipient Pointing to the Scalix Group
To create a custom recipient that points to the Scalix group:

1 In Exchange Administrator, choose File / New Custom Recipient.

The New Email Address dialog box appears. 

2 Select "Internet Address" and click OK.
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The Internet Address Properties DB appears. 

3 Click in the Email Address field and type the Scalix group's full email address.

E.g, “sales-pdl@mailserver.scalix.company.com”

4 Click OK to proceed.

The Properties DB appears. 

5 Click in the Display field and type the Scalix group's name (probably the same 
name as the original Exchange PDL).

6 Click in the Alias field and type the scalix group's full email address.

• Ignore all the other fields.

7 Click Apply, then click OK, to close this dialog box and save your entries.
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8 When Exchange reappears, open the Lists menu and choose Custom Recipi-
ents. 

The new custom recipient should appear in the now-visible list.

Removing the Exchange auto-forward from this group address in Scalix
To remove the auto forward from this group address:

1 Remove the auto-forward from the Scalix Group/Public Distribution List that refers 
to the original Exchange Public Distribution List.

Setting up the auto-forwarding for the Exchange group
To set up the auto forwarding for the Exchange group:

1 In Exchange Administrator, double-click the original PDL entry to open that list’s 
Properties dialog box. 

2 Click the Modify button below the Users list (as highlighted above). 
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The Distribution List [Name] dialog box appears. 

3 Select and delete all the entries in the "Distribution List Members" list (as high-
lighted above). 

4 In the same dialog box, locate the custom recipient (representing the Scalix group). 

5 Select it and click Add ->.

6 Click OK to save the change and close the dialog box.

7 When the Properties dialog box reappears, click Apply, then click OK to save your 
changes.

Hiding the Custom Recipient from Exchange View
You should now hide the custom recipient that refers to the Scalix group address. 

To hide the recipient:

1 Start Exchange Admin.
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2 Open the List menu (in the Exchange Administrator toolbar) and choose Custom 
Recipients. 

3 Locate and double-click the Scalix-group custom recipient in the list that appears.

4 When the [RecipientName] Properties dialog box appears, click the Advanced 
tab. 

5 In the Custom Recipient Options, click the check box by Hide from address 
book (as highlighted above).

6 Click Apply to activate your changes, then click OK to close the [RecipientName] 
Properties dialog box.

7 You can exit Exchange Administrator.

What happens?
Any remaining Exchange users can address messages to the same Exchange-based Public Dis-
tribution List that now has only one member—the custom recipient that contains the Inter-
net Address of the corresponding Scalix Server Public Distribution List.   

You can now switch administration of this distribution list (including additions or deletions 
of recipients) to the Scalix Server copy.
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Switching PDL Management After Coexistence 

If you switch Distribution List management after coexistence (when there are no more 
actively used mailboxes on Exchange), you must add all relevant users to the Scalix Server 
Distribution List in one of two ways:

• Using the Web Administration client

• Open a terminal window (CLI) and run the omaddpdln command

Adding a number of names to a Scalix Public Distribution List can be made more efficient by 
extracting the original Exchange recipient list to a convenient text file, then formatting the 
file for importation into Scalix.

Copying the PDL list from Exchange
To copy the PDL list from Exchange:

1 In Microsoft Exchange Server Administrator, open the Recipients container where 
the Public Distribution Lists are stored. 

2 Right-click the appropriate Public Distribution List entry and choose Properties.

The [ListName] Properties dialog box appears. 

3 In the General tab, click Modify.
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A Distribution List [name] dialog box appears. 

4 Select all of the list’s users (by clicking in the Members list and pressing Control-A) 
and copy them to the Windows clipboard.

5 Close the Distribution List and Properties dialog boxes.

6 Open a new Notepad or Wordpad document and paste the collection of users into 
the document window. 

7 Save this document as Dlist.txt.

8 You can exit Exchange Administrator.

Formatting the List File for Importation
To process this text document in Microsoft Excel for use in Scalix:

1 Open a new Excel workbook.

The active cell should be A1. 

2 Choose Data > Import External Data > Import Data.
175



Scalix Migration Guide | Task 21: Post-Migration and Coexistence Closure Tasks
The Select Data Source DB appears. 

3 Locate and select the user names text file. 

4 Click Open. 

The Text Import Wizard appears. 

5 In Text Import Wizard 1/3, click the Delimited button.

Tip: take advantage of the "preview" pane in the lower half of this dialog box to 
verify your text file's contents.

6 Click Next.
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The Text Import Wizard 2/3 appears. 

7 Click the Delimited check box. (Make sure this is the only active selection. 
Uncheck any others.)

8 Make sure that both first and last names are sorted into the same cell/column as 
shown in the preview area of this dialog box.

9 Click Next.

The Text Import Wizard 3/3 appears. 

No changes are needed.

10 Click Finish.
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The Import Data dialog box appears. 

11 Click OK. (The default location should be the current worksheet, in cell =$A$1)

Row 1 should display names from the list, one first/last name pairing per cell. 

12 Select the entire row. (Selecting empty cells does not affect this procedure.)

13 Copy the row’s contents to the Windows clipboard.

14 Open a new Excel workbook.

(Cell A1 is auto-selected.)

15 Choose Edit / Paste Special

The Paste Special dialog box appears. 

16 Click the check box by Transpose. (All other default settings are OK.)

17 Click OK to complete the pasting of data. 
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Excel redistributes the first and last names in Column A. 

18 Due to the default column width, the name entries may appear to spill into column 
B, and maybe C. Widen Column A (as shown above) to verify that each first/last 
name pairing fits in its own Column A cell.

19 Save this file/workbook as a text file for importation into Scalix.

20 Print the file.
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Part 4

Migrating an IMAP 
system to Scalix



Completing an IMAP–IMAP
Mail System Migration

If your current mail system allows only IMAP4 or POP3 access and/or if the system has no 
LDAP v2 support, you can still migrate the users and their data from that legacy system to 
Scalix. This chapter will guide you, step-by-step, through a “flash” data migration from any 
e-mail system that supports IMAP4 protocol to Scalix (also using IMAP4 protocol). 

This particular migration process employs a set of utilities included in Stellar (formerly 
CompuSven) E-Mail Shuttle.

Requirements

• A Windows 2000 or XP-installed workstation

• Microsoft Office 2000 or XP

• An extractor code for E-Mail Shuttle, provided by Stellar or Scalix

• The administrator account login for Scalix

• The administrator account login for your legacy IMAP server

Installing and Setting up Stellar E-Shuttle

1 Install E-Shuttle (as directed by the Stellar documentation.) 

This requires downloading the installer package from the Stellar Website, unzipping 
the package, then starting and running the installer program.   

2 When working through the installer wizard, make sure you choose the following:

• Extractor — “any IMAP4-compliant system” 

• Loader — “any IMAP4-compliant system” 

3 To complete the installation, select the appropriate directories where you wish to 
install E-mail Shuttle. (The Windows “Program files” default values are accept-
able.)
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Getting Started

You can now configure E-Mail Shuttle through the Mission Control application. 

1 Choose Start >Programs >CompuSven E-Mail Shuttle Applications >Extractor >E-Mail 
Shuttle Tools >E-Mail Shuttle Mission Control for IMAP4 

The E-mail Shuttle Mission Control window appears. 

The default settings in the window tabs are acceptable, with two exceptions: the 
Misc and IMAP tabs.

2 Click the Misc tab (shown in the previous illustration).

3 Click in the Authorization Code field and type the extractor code.

4 Click the IMAP 4 tab. 

5 Click in the Host Name field and type the fully-qualified domain name of the leg-
acy IMAP4 server.

• Leave the Launch Pad Name and Launch Pad Password empty.

• The “143” value in the Host Port is an acceptable default for IMAP4.
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6 Exit the IMAP Extract Mission Control application. 

This will update the \eshuttle\Extractor\IMAP4\eshuttle.ini file with your new 
entries.

Before proceeding with migration
YOu may want to test the following migration process on a small sampling of users, before 
undertaking the migration of your entire system.

Loading the Mailboxes on the Scalix Server

The next step is to load (provision?) the mailboxes on the Scalix server. There are sev-
eral way to do this:

• Use the Scalix Management Console

• Use the omaddu command

• Use a combination of omldapsync and ommigu

• Using more advanced methods that use auto-forwarding mechanisms.

The most important consideration is to make sure that the primary Internet Address of the 
Scalix user is loaded correctly before initiating any mailbox migration.

Listing the Current System Users
The first phase is to create a file that lists the users on the legacy IMAP4 mail system. The 
filename must be named “shuttlin*” (with an asterisk) and have a file extension of “.txt”. 

Example: shuttlin1.txt 

There are two ways to create a shuttlin*.txt file:

• Use the EShuttlin Edit application provided by Stellar 

• Use any other editing application (Windows or Linux/Unix) that can save the contents 
of a file as ASCII text. The file format and content format information are provided.

1: Using EShuttlinEdit
Stellar provides the EShuttlinEdit program (EShuttlinEdit.exe), stored in the \EShut-
tle\Extractor\IMAP\Users\ directory. 

1 Start EShuttlinEdit (with the Start menu).
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The Eshuttlin Edit Program window appears. 

2 Choose File >Open/New.

The Open Existing/Create New File dialog box appears. 

3 Enter a name for the file in the File Name field, ending the filename with a “.txt” 
extension. (Make sure the file type is “Text file”.

4 Use the dialog box features to navigate to the target directory:

\Eshuttle\Extractor\IMAP\Users directory

5 Click Open.
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The Select File Type dialog box appears. 

6 Click the button by IMAP

7 Click OK to save the file type selection.

The Eshuttlin Edit program window reappears, listing the new file name in the title 
bar. 

8 Fill in the Legacy and Destination fields to add information for a current user.

The entries include the following: 

User Name The login name used for access to the IMAP4 server. 
Quite often this is formatted as “First Last”, but 
optionally “FirstLast”, or “First.Last”. On some 
systems, it may be an internet email address 
(first.last@domain.com).

First Name The first name of the user, sometimes referred to as 
the given name.
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Last Name The last name of the user, sometimes referred to as 
the surname.

Forwarding Address The internet address for the user on the legacy IMAP4 
server. (In this format: [name]@pop.company.net)

Password The password used to access the mailbox on the legacy 
IMAP4 server.

Destination Values include the following:

DBTitle The primary internet address of the corresponding 
mailbox on the Scalix server.

Path The password used for access to the Scalix mailbox

DBServer The fully qualified domain name of the Scalix server

DBName This value should always be DBTitle

9 Click Add to store this user’s information. 

10 When you are finished making entries, exit the Eshuttlin Edit application.

2: Using a Text Editor or Spreadsheet
You can also create a shuttlin*.txt file using an application (Microsoft Word, Excel, NotePad, 
etc.) that saves files in a text (*.txt) format. The contents must be organized according to 
these requirements:

• The file must begin with a single ES_System^IMAP^ line. 

• Each user’s information must be placed in a separate ES_Export line. 

• Placement of the “^” delimiter characters as letter- and word-spacing is important, as 
shown here: 

Extracting the Mailbox Contents

After completing the shuttlin*.txt file, you can run the E-Mail Shuttle extractor. This appli-
cation, IMAPExtract.exe, can be found in the \Eshuttle\Extractor\IMAP directory 

1 To run this application, open a command prompt window and type

IMAPExtract console

The extractor script will automatically open the users’ list and start the extraction.

Note The Create button has no purpose. You can ignore it for this task.

ES_System^IMAP^

ES_Export^Ed Fry^^^^pa$$w0rd^ed.fry@cpg-

corp.com^Ed^Fry^ed.fry@cpg-

corp.com^123456^scalix.cpgcorp.local^DBTitle^
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The results of the extraction process will be displayed on the screen (and will be 
logged in the EShuttle\Extractor\IMAP\LogFile directory.) 

A sample of successful results is shown here:

==================================================================

=========

Tue Dec 07 13:33:04 2004    User [Dan Smith] Summary: 

Tue Dec 07 13:33:04 2004   

Tue Dec 07 13:33:04 2004    Successfully unloaded: 4 messages 

Tue Dec 07 13:33:04 2004                           3 folders

Tue Dec 07 13:33:04 2004    Errors:

Tue Dec 07 13:33:04 2004        0 messages not unloaded due to 

errors

Tue Dec 07 13:33:04 2004                   0 folders not unloaded 

due to errors                             

Tue Dec 07 13:33:04 2004    

==================================================================

=========         

Loading the Extracted Data onto Scalix

After extracting the data from your legacy mailboxes, you can run the loader and transfer 
the data from the previously-created .txt file to Scalix mailboxes. This application can be 
found in the \Eshuttle\Loader\IMAP directory, named: “IMAP_Loader.exe”.

1 To run this application, open a command prompt window and type

IMAP_Loader ?debug

Results of the data loading process will be displayed on the screen (and will be 
logged in the EShuttle\Loader\IMAP\LogFile directory.) 
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Guide to Synchronization Commands

Successful communication between the Scalix Server and Exchange server requires that you 
synchronize entries in both the Scalix Server and Exchange directories. Later in the migra-
tion process, the directory entries are used to set up mailboxes on the Scalix Server and 
enable coexistence between both e-mail systems.

The directory synchronization process uses Lightweight Directory Access Protocol (LDAP) as 
the method for exchanging directory entries. As described in XREF, coexistence uses a single 
connection point between Scalix Server and Exchange. 

The omldapsync command is the tool that you use to synchronize Scalix Server and Exchange 
directories. The omldapsync command is executed on the Scalix Server and uses a mapping 
file which is created during the Scalix Server installation. If required, you can edit the map-
ping file at any time to make configuration changes.

For every synchronization agreement (or relationship), omldapsync creates a directory that 
contains configuration files, logging files, and Import and Export subdirectories. The Import 
directory contains files used during the Exchange-to-Scalix Server synchronization, and the 
Export directory contains files used during the Scalix Server-to-Exchange synchronization.

Because LDAP is typically used as a directory search tool rather than a directory synchroni-
zation utility, you must modify some default settings for LDAP on the Scalix Server and the 
Exchange server to enable the directory integration to operate correctly.

OPTION: omldapsync Interactive Menu Options

You can use the omldapsync command in two ways. You can use omldapsync in “interactive” 
mode, or in “command-line” mode, which allows you more control over omldapsync. 

When you execute omldapsync in “interactive” mode, you can do the following:

• Create the synchronization agreement

• Perform an initial synchronization of the directories

• Update the directories based on changes since the last synchronization

• Accept manual error-correction modifications to the directories (for errors detected 
during the synchronization)

1 To execute omldapsync in “interactive” mode and perform omldapsync tasks, enter 
the following command: 

omldapsync -i syncid

The following menu options appear:
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0. Display this menu

1. Configure the LDAP dir sync settings

2. Load the directory for the first time

3. Update the directory after some changes

4. Accept previous error and update directory

q. Quit

2  Enter the appropriate number to proceed. 

Synchronization Menu 

This section lists the commands available in the interactive menu and the specific tasks you 
can perform with those commands.

0 Displays the omldapsync menu.

1 Allows you to configure the synchronization agreement. If an agreement does not 
exist for the agreement name you enter, omldapsync creates a new directory struc-
ture and corresponding files.

2 Allows you to perform an initial synchronization of the Scalix Server and Exchange 
directories. omldapsync extracts all entries from the Exchange directory and cre-
ates a file which it imports to the Scalix Server directory. omldapsync also extracts 
all entries from the Scalix Server directory and creates an import file for the 
Exchange directory.

Note that you should only perform an initial synchronization once. While it is possi-
ble to execute an “initial synchronization” several times, omldapsync returns errors 
if you do not delete all remote recipient entries in both the Scalix Server and 
Exchange directories before executing the initial synchronization again. To accept 
these errors, select option 4.

3 Synchronizes the directories on the Scalix Server and Exchange servers by comparing 
the current export file (which is created by selecting this option) with the previous 
export file.

omldapsync adds, deletes, and modifies entries in the appropriate directory. Note 
that Import directory corresponds to the Exchange server, and the Export directory 
corresponds to the Scalix Server.

4 Select this option only when you want to accept errors that occur during the syn-
chronization process.

When you accept errors indicates that a conflict exists between the Exchange and 
Scalix Server directories, or that a conflict has been resolved (see Option 2 for more 
information).

Note that accepting errors causes omldapsync to disregard the error condition dur-
ing future directory synchronizations.

Correcting errors typically involves modifying one or more directory entries on the 
Scalix Server or the Exchange server.
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q Quits the omldapsync command. 

 Synchronization Command Options

The following section details the options that can be used with the omldapsync command. If 
you want more control over the process, use the following with omldapsync in place of the 
interactive menu.

-s sync id Displays details of the agreement. If the synchronization agreement ID does 
not exist or is set to all, all available synchronization agreement IDs are dis-
played. Otherwise, the most recent log file for the synchronization agree-
ment ID is displayed.   

-c sync id Configures synchronization agreement. If the synchronization agreement ID 
does not exist, you are prompted to create a new agreement.   

-r sync id Deletes synchronization agreement information. All files and data associ-
ated with this agreement is deleted from the Scalix Server. Imported and 
exported directory entries are not deleted.   

-i sync id Displays the interactive menu for the agreement.    

-l sync id Loads the directories using the synchronization agreement. This option is 
used to populate the directories with the initial contents of each system for 
the first time. If -I is used in with the -l option, an import occurs. Using -E 
with -l option executes an export to the Exchange server. Using the -l option 
exclusively executes both an import and an export.

Note: You can use this option to resynchronize information. However, you 
must manually delete the already imported and exported entries.    

-u syncid Updates the directories using the synchronization agreement. Use this 
option to keep the directories up-to-date. Use this option after the first-
time synchronization (the -l option). 

If -I is used in with the -u option, an import occurs. Using -E with -u option 
executes an export to the Exchange server. Using the -l option exclusively 
executes both an import and an export.

Use the -A option to accept any previously reported errors.

-d level Debugs the command execution. The default level is 0, which generates sta-
tus and information messages. To generate more messages for debugging 
purposes, set the level to 1, 3, 7 or 15. The greater the value you enter, the 
more output the command produces. However, this can reduce the perfor-
mance and create large log files. 

Note: Use a system scheduler such as cron to update directories on a regular (hourly, daily, 
weekly, etc.) basis.

Note: Output for last execution of omldaputil is saved in the omldaputil.log file in the respective 
import or export directory.
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Synchronization Command Examples

• To list all agreements present on the system, enter:

omldapsync -s all

• To configure a new or existing agreement named “100”, enter:

omldapsync -c 100

• To interactively choose common tasks for agreement 100, enter:

omldapsync -i 100

• To load directories for the first time with agreement 100, and use debug level 3, 
enter:

omldapsync -l 100 -d 3

• To accept previous errors and update the import directory with agreement 100, enter:

omldapsync -u 100 -I -A
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Glossary

Some terms and acronyms in this manual may be unfamiliar to users. Here are some terms 
and definitions that are specific to the Scalix product and the Linux platform.

Table 1: Terms and their Definitions

Term Definition

Address Directories

In Scalix terminology, the address directories are databases that clients use to look 
up names and addresses. Scalix directories can hold addresses of both Scalix and 
non-Scalix users, and other information that an administrator can configure such as 
job titles and phone numbers. Directories can be searched by any number of 
attributes.

Management Console or SAC

The Scalix Management Console (SAC) is a browser-based application that enables 
most day-to-day system administration tasks on a Scalix messaging system through 
an easy-to-use GUI. It is a separate component of Scalix that users can access with 
any approved browser on either Microsoft Windows or Linux workstations. SAC pro-
vides efficient access to a wide range of Scalix server options, including user 
account management, starting and stopping server services, administering queues, 
public distribution list or group management, and changing low-level server configu-
ration settings. It also provides system monitoring to assess the status of processes 
and resources.

ADUC (Active Directory Users and Computers)...

Authentication Identifier

The Scalix system has several ways of identifying users for different purposes: Dis-
play names, personal names, authentication IDs and Internet addresses. The dis-
play name (also known as a “common name”) is used in Outlook and other clients as 
the “displayed” address. It can serve authentication purposes and determines the 
sort order in the Outlook address book. Authentication IDs support the concept of a 
separate login name and allow for integration with external authentication systems 
that may have their own naming rules. Internet addresses are SMTP addresses of 
the form name@domain. Personal names are used for internal addressing of email 
and are sometimes referred to as “X.400 addresses,” “OpenMail addresses” or 
“ORN (originator Recipient name.” 

Bulletin Board
In Scalix terminology, a bulletin board is a set of public folders where members can 
share files, ideas, documents and more. They are a shared area in the Scalix mes-
sage store. 

Clam AV An open source freeware program that protects against viruses.
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Community Edition The free, single-server, unlimited-use version of the Scalix product. Does not include 
advanced groupware and collaboration functionality.

Display Names vs User Names vs 
Personal Names vs authentication ID 
vs Internet address

The Scalix system has several ways of identifying users for different purposes: Dis-
play names, personal names, authentication IDs and Internet addresses. The dis-
play name (also known as a “common name”) is used in Outlook and other clients as 
the “displayed” address. It can be used for authentication purposes and determines 
the sort order in the Outlook address book. Authentication IDs support the concept 
of a separate login name and allow for integration with external authentication sys-
tems that may have their own naming rules. Internet addresses are SMTP 
addresses of the form name@domain. Personal names are used for internal 
addressing of email and are sometimes referred to as “X.400 addresses,” “OpenMail 
addresses” or “ORN (originator Recipient name.” 

Enterprise Edition
The company’s flagship product, which includes multi-server support, unlimited 
number of Standard users, any number of Premium users, the full complement of 
Scalix advanced capabilities, and a wide variety of technical support options.

Gateway

Gateways are a way of passing messages out of the Scalix network to different mail 
environments. The gateway converts outgoing messages from a Scalix format to a 
format that external services can use to do send processes, and later to a format 
that target environments can receive such as an SMTP address. Scalix comes with 
a standard SMTP gateway that converts Scalix-formatted messages to SMTP and 
vice-versa. This SMTP gateway is called the Unix Mail Gateway or Internet Mail 
Gateway. 

Groups and PDLs
In Scalix terminology, the terms “group” and “PDL” are used interchangeably to 
mean a group of people organized into a mailing list. PDLs can contain both local 
and remote users, and can contain nested PDLs.

IMAP

(Internet Message Access Protocol) A standard interface between an e-mail client 
program and the mail server. In Scalix, the iMAP4 server enables a client to: 
Access, list, read, and delete items from inboxes, filing cabinets and public folders; 
read parts of a message without downloading the entire thing, keep a record of 
which messages have been read, and update messages on the server from a client. 
IMAP extension also provide for calendaring and contact management.

Internet Domains vs mailnodes

Mailnodes have no direct relationship to Internet domains. However, you can set up 
rules so that when a user is created on a mailnode, Internet address generation 
kicks in and creates an Internet address for the user. You can map multiple mailn-
odes to the same Internet domain name.

LDAP

(Lightweight Directory Access Protocol) A protocol used to access a directory listing. 
In Scalix, the LDAP server is a daemon process based on a client/server model that 
provides an interface to enable LDAP clients to store and retrieve data from a Scalix 
directory without any information about the operation of Scalix. It provides LDAP cli-
ents access to shared Scalix directories that do not have an associated password.

LVM (Logical Volume Manager) Used for backing up Scalix directories. 

Table 1: Terms and their Definitions

Term Definition
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Mail Nodes

A logical structure used to organize users into administrative groupings. For exam-
ple, some companies organize their email users by work group whereas others 
break their users down by employment status. Each Scalix server is associated with 
a single mail node created during installation. After installation, you can use the 
Management Console to create additional mail nodes on a server, including custom-
izing any new mail nodes with a specific Internet address or domain name. 

MAPI

(Mail API) A programming interface from Microsoft that enables a client application 
to send to and receive mail from Exchange Server or a Microsoft Mail (MS Mail) 
messaging system. Microsoft applications such as Outlook, the Exchange client and 
Microsoft Schedule use MAPI.

Message Store

The message store is a collection of flat Linux files held in file system directories on 
the Scalix server. It holds new messages received as well as messages in transit. 
For clients that use the message store (server-based clients), It also holds old mes-
sages that are files for reference in folders, copies of outgoing messages, draft mes-
sages, private distribution lists, personal information such as calendaring, tasks, 
bulletin boards, public folders and more.

Mx Records Mail exchanger records inside DNS servers. These decide which server is responsi-
ble for dealing with mail or domain DNS actions.

OpenMail The original technology, licensed from Hewlett Packard, upon which the Scalix sys-
tem is based.

O/R or Originator/Recipient Address
An attribute list that distinguishes one user, or distribution list, from another and 
defines the user's point of access to the message handling system or the distribution 
list's location. 

PAM
(Pluggable Authentication Modules). A standard library in Linux that connects appli-
cations that require authentication with shared library modules interfacing with 
authentication mechanisms. 

PDL
In Scalix terminology, the terms “group” and “PDL” are used interchangeably to 
mean a group of people organized into a mailing list. PDLs can contain both local 
and remove users, and can contain nested PDLs.

Personal Name

The Scalix system has several ways of identifying users for different purposes: Dis-
play names, personal names, authentication IDs and Internet addresses. The dis-
play name (also known as a “common name”) is used in Outlook and other clients as 
the “displayed” address. It can be used for authentication purposes and determines 
the sort order in the Outlook address book. Authentication IDs support the concept 
of a separate login name and allow for integration with external authentication sys-
tems that may have their own naming rules. Internet addresses are SMTP 
addresses of the form name@domain. Personal names are used for internal 
addressing of email and are sometimes referred to as “X.400 addresses,” “OpenMail 
addresses” or “ORN (originator Recipient name.” 

Table 1: Terms and their Definitions

Term Definition
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POP

(Post Office Protocol) A standard interface between an e-mail client program and 
the mail server. The Scalix POP3 server enables clients to list, read and delete 
items from the inbox area of the Scalix message store. The Scalix POP3 server 
does not provide access to any other areas of the message store such as public 
folders.

Premium Users

Scalix has two levels of access and usage: Premium and Standard. Premium users 
have access to the full benefits and functionality of the Scalix email and calendaring 
system. Standard users gain access to a subset of Scalix functionality including 
email, personal calendar and contacts through Scalix Web Access and Novell Evo-
lution as well as email access using POP/IMAP clients. 

SAC

The Scalix Management Console (SAC) is a browser-based application that enables 
most day-to-day system administration tasks on a Scalix messaging system through 
an easy-to-use GUI. It is a separate component of Scalix that users can access with 
any approved browser on either Microsoft Windows or Linux workstations. SAC pro-
vides efficient access to a wide range of Scalix server options, including user 
account management, starting and stopping server services, administering queues, 
public distribution list or group management, and changing low-level server configu-
ration settings. It also provides system monitoring to assess the status of processes 
and resources.

Scalix Connect A MAPI application that enables the use of the Outlook client interface and all of its 
functionality.

Sendmail An SMTP-based message transfer agent (MTA) that runs under Unix and Linux. It is 
the mail transfer process used inside the Scalix system.

SSL

(Secure Socket Layer) A protocol for transmitting private documents via the Internet. 
SSL uses a cryptographic system that uses two keys to encrypt data - a public key 
known to everyone and a private or secret key known only to the recipient of the 
message.

Small Business Edition

A version of the Scalix system that targets organizations getting started with a com-
mercial version of Scalix that do not have the higher end requirements of Enterprise 
Edition. It is functionally equivalent to Enterprise Edition except that it allows only 
single-server installations 

Spam Assasin An open source freeware program that filters spam.

Standard Users

Scalix has two levels of access and usage: Premium and Standard. Premium users 
have access to the full benefits and functionality of the Scalix email and calendaring 
system. Standard users gain access to a subset of Scalix functionality including 
email, personal calendar and contacts through Scalix Web Access and Novell Evo-
lution as well as email access using POP/IMAP clients. 

SWA Scalix Web Access, the browser-based email, calendar, contacts and public folders 
client that comes with any Scalix installation.

Transports

Transports are services that Scalix uses to pass Scalix format messages to other 
Scalix services. Scalix uses Sendmail and SMTP formatted messages to send mes-
sages between servers in the Scalix network, but other connections can be written. 
The transport service on the Scalix server is called the Sendmail Interface. 

Table 1: Terms and their Definitions

Term Definition
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UAL (User Access Layer) A proprietary Scalix protocol that enables communication 
between clients and the Scalix server.

WAP (Wireless Application Protocol) A standard for providing cellular phones, pagers and 
other handheld devices with secure access to e-mail and text-based Web pages. 

Table 1: Terms and their Definitions

Term Definition
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